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Scenario 360 tutorials 

These CommunityViz tutorials provide tutorial instructions aimed at familiarizing you with the procedures and 
concepts necessary for working with Scenario 360, Scenario 3D and related tools like Google Earth.  These 

tutorials are just fictional examples, and although they represent realistic decisions that people face every day, 
the data and assumptions used are simply for illustration. The analyses have no “right” answers and are not 

meant to imply any bias on any of the issues considered. 

There are seven tutorials.  Tutorial 1 gives a broad overview of capabilities, and Tutorial 2 introduces some basic 
concepts in more detail.  If you are new to ArcGIS, you may prefer to start with Tutorial 2 and then return to 

Tutorial 1 before proceeding through the other tutorials.   

 

• Tutorial 1 – This tutorial gives you an overview of the capabilities of Scenario 360 by applying "decision 

tools" (Suitability, Land Use Designer and Sketch Tools, Build-Out, TimeScope, Common 
Impacts and Custom Impacts Wizards) in combination with one another to create a comprehensive 

growth analysis. 

• Tutorial 2 - Explore an existing analysis.  This tutorial uses two scenarios (rural and village type 

development options) to walk you through investigating variables that affect development suitability and 
road construction cost models.   

• Tutorial 3 – Set up your own analysis.  This tutorial will walk you through creation of a cost analysis in an 

urban environment.  

• Tutorial 4 – Create and work with a Scenario 3D scene.  This tutorial will walk you through the creation 
of a 3D scene, including terrain and textures.  You can then “fly” around and through the landscape and 

its features.  

• Tutorial 5 – Run a Build-Out analysis.  This tutorial will walk you through setting up and running a more 
detailed numeric, spatial, and visual build-out than you did in Tutorial 1. 

• Tutorial 6 - Run an analysis and create presentations.  This tutorial will walk you through displaying 

analysis information, creating saved views, comparing scenarios, and creating web-ready reports and 

analyses.  

• Tutorial 7 - Export your analysis to Google Earth and display different TimeScope build dates in the 3D 
world of Google Earth.  

Remember that these tutorials represent only a subset of what is possible in CommunityViz Scenario 360 and 
Scenario 3D. 

 

Before you begin 

 Have a working knowledge of ArcMap – The CommunityViz tutorials assume that you have a working  

knowledge of ArcMap.  For assistance with ArcMap and ArcGIS tools, see the ArcGIS help. 

 Install CommunityViz - Install Scenario 360 and Scenario 3D.  Activate your license using the License 

Activation Wizard.  For detailed instruction on installing Scenario 360 and Scenario 3D, refer to the 

installation instructions provided with your software. 

Install the tutorial data - The data required to use these tutorials is provided online at 

http://communityviz.city-explained.com/communityviz/resources.html.  On the Tutorials tab at the 
bottom of the resources page, click on the Tutorial Dataset Installer.  In the File Download – 

Security Warning window, click Run to automatically load the tutorial data into the C:\CVFiles\ 

directory on your computer. If prompted with a security message such as “Do you want to run this 

software…,” say yes.  

The tutorial data must be installed in the exact location used by the installer, which is C:\CVFiles\.  Do not 
attempt to move the files to another location or subdirectory.  However, you may wish to make a compressed 

(“zipped”) copy for backup purposes.  The tutorial data will be included in four folders in C:\CVFiles:  
Buildout, Communityville, Sunny Vista and Tutorial 3.  In addition there will be a PDF copy of the Tutorial 

instructions (these instructions) in the CVFiles directory.  **Please be sure to remove all old tutorial files, if 

any exist, before you start this tutorial.**   

http://communityviz.city-explained.com/communityviz/resources.html
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 Print these instructions.  If desired, print a paper copy of these instructions to use as you work through 
the tutorials. 

 

About working with tutorials 

 You can start and stop any time – To start Scenario 360, double-click the 360 icon on your desktop. 

This will automatically launch ArcMap with the Scenario 360 extension enabled.  To stop, simply close the 
ArcMap window. You will be asked whether you want to save or discard your work.  If you are already in 

ArcMap, you can launch Scenario 360 at any time by clicking the red Start Scenario 360  button on 

the Scenario 360 toolbar.  Use the same button to switch to a different Scenario 360 analysis. 
 Saving copies – To save your work at any time, click File | Save from the top of the ArcMap window.  

If you want to make a copy of a Scenario 360 analysis, click File | Save Analysis As… from the top of 
the ArcMap window and save the analysis with a new name.  Always save analyses to the C:\CVFiles\ 

location.  Please do not try to copy analyses or rename analyses using Windows Explorer, and do not 
create your own subdirectories. 

 If you make a mistake – Don’t worry!  Most of the time you can go back and do something over.  If 

you are in the middle of using a Wizard, simply use the Back button to return and make changes.  If you 
have already closed the Wizard, open it again and step through until you get to the part you need to 

change.  If all else fails, you can close the analysis (use the red X on the ArcMap window) and choose to 
Discard Changes. 

 Question boxes – If you are asked whether you want to “Convert to a File Geodatabase,” or if you want 

to “Create Indexes,” say yes. 
 If your screen isn’t the same as the instructions – Do not be concerned about small differences 

between the images in these instructions and the display on your screen.  The particulars of what you 
see will depend on your computer and your set up, especially for layers displayed on the map, colors, and 

screen layout.  You may find it helpful to turn layers on or off in your display to match the illustrations. 
 If buttons are grayed out (inactive) – Make sure you have stopped editing.  Make sure that Scenario 

360 and Scenario 3D are installed and licensed (check the ArcMap Customize| Extensions… menu).  

You can also look for useful messages in the lower left corner of your screen that appear when you hover 
your cursor over a button. 
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Tutorial 1 – Integrated analysis using decision tools 

This tutorial will give you a good overview of the capabilities of Scenario 360 that are provided by the decision 
tools for community planning. This tutorial contains a series of exercises that demonstrate how to use the 

decision tools with one another in the course of a comprehensive growth analysis.  It starts with a Suitability 
analysis that selects the best places to build, followed by a land use sketching exercise using Land Use 

Designer. Then comes Build-Out and TimeScope to simulate the development and its changes over time.  

Finally, the tutorial uses the Common Impacts and Custom Impacts Wizards to evaluate some of the 
development’s effects.   

 
The purpose of this tutorial is to provide some examples of how Scenario 360 decision tools can be used on their 

own or in combination with one another.  The sequence we’ve chosen is just one example of the many ways you 
can use these modular components.  The tutorial does not go into great detail on any of the individual decision 

tools, but it is intended to give you an idea of what each one can do and provide some examples of how they can 

be used together. 
 

Once you have installed the tutorial data using the “Install the tutorial data” directions in the Before you Begin 
section, you will find this analysis in the CVFiles\Sunny Vista folder. 

 

 
Objectives 

• Rate the suitability and desirability of parcels in two different scenarios  

• Create and apply land use styles to existing parcels to explore potential impacts 

• Run a standard build-out analysis for some proposed land use areas 

• Estimate potential build dates for structures in your plans using build rates and order options in 

TimeScope. 

• Estimate the impacts of building over time using the common and custom impacts decision tools 

 

Starting the tutorial 

1. Refer to the Before you begin section if you 

haven’t already installed the software and data for 
this exercise. 

2. Start Scenario 360 by double-clicking on the red 

Scenario 360 icon  on your desktop.   

3. On the Scenario 360 Welcome “splash” screen, 

click Open Existing Analysis, browse to the 

CVFiles/Sunny Vista analysis, select it, and click 
OK.  If asked about converting to a File 

Geodatabase, click YES.  Scenario 360 will load 
and display a fictional place called “Sunny Vista.”  

Sunny Vista is a high mountain site on the 
outskirts of a mountain town being considered for 

development. 

4. All decision tools referenced in the following 
exercises are available from the main Scenario 

360 toolbar | Scenario 360 drop-down | Tools or 
from a separate Scenario 360 Decision Tools 

toolbar, depending on your toolbar preferences. 
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Setting up a suitability analysis 
The Scenario 360 suitability decision tool (the Suitability Wizard) helps you set up an analysis that scores 

geographic features based on their suitability or desirability for a particular application.  For example, you can 

calculate which parcels are best for building, which tracts are most important to preserve, or which locations are 
most likely to attract retail business.  (The same kind of analysis can be used for risk or vulnerability assessment, 

too.)  These separate factors are rated independently and then combined to produce a final suitability score.  
Optionally, variable weights can be applied to each factor so that the final analysis places more importance on 

some factors and less on others. 

In this exercise you will rate the development suitability of individual parcels based on how close each one is to a 

water well and whether or not it lies within elk grazing habitat. 

1. You can access the Suitability Wizard using the Scenario 360 toolbar.  Click the Scenario 360 drop-down 

list and select Tools  Suitability Wizard. 

 

      

2. Ensure the Create a new suitability measure radio-button option is selected. 

3. Select Parcels in the dropdown list after “Rate suitability for the dynamic layer:” 

4. Accept the default name of Suitability and click Next. 
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Specifying new suitability factors 

1. You will see a new screen called Set up Suitability Measure.  Click the Create a new suitability 

factor  button. 

2. In the Set up Suitability Factor window, specify the factor name Well Proximity and keep the 

default for factor type as This factor is a consideration.  Leave the default method as Proximity to 
other features and default Proximity Type as Distance to Nearest Feature, and select the Water 

Wells layer from the Target Layer dropdown list.  Also leave in place the default setting that “Higher” 

scores result from closer proximity.  These settings will create a suitability factor rating that is highest for 
parcels that are closest to wells and lowest for parcels that are furthest from wells. 

3. Click Next. 

 

4. Accept the default option to create  weighting and Yes/No assumptions for this factor by clicking Next 
again at the Variable Weighting screen. 

5. Now you will create another new factor that will contribute to the suitability measure for your parcels.  

Click the Create a new suitability factor  button on the Suitability Measure Summary page. 
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6. Name this factor Habitat Overlap, keep the default for factor type as “This factor is a consideration, 
and choose the Amount of overlap with another layer method.  Select the Elk Grazing Habitat 

layer from the Target Layer drop-down list and specify that “Lower” scores result from more overlap. 

7. Click Next then click Next again to accept the default option to create weighting and Yes/No 

assumptions for this factor. 

 
 

8. Optional Step: Create a third factor by repeating the steps above.  Name this factor Slope and choose 

the Average value of underlying grid method.  Select the Slope layer from the Grid Layer drop-down 
list and “Lower” from the scores result drop-down list.  This indicates that lower scores will result from 

higher grid values.   
 

 
 

9. Click Next twice to accept the defaults as before, which will return you to the Suitability Measure 
Summary page.  

10. Do not click Finish at this time.  
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Running the suitability analysis 

You have now created three factors.  Each of these will contribute to the suitability rating for your parcels.  Take 

a moment to think about what these mean and how you created them. The Suitability Measure Summary 

page should display the three factors you just created: Well Proximity, Habitat Overlap and Slope.   

 

1. Ensure the option Create a TimeScope 
phase attribute named ‘TimeScope 

Suitability’ is checked.  This will create 

an attribute that is designed to work with 
the TimeScope decision tool.  Its values 

will be lowest for the most suitable 
parcels and highest for the least suitable 

parcels.  Later, you will use this attribute 
to cause TimeScope to build on the most 

suitable (and presumably most desirable) 

parcels first.   (TimeScope always builds 
in order from lowest values to highest.) 

 

2. You are now ready to run your suitability 

analysis.  Click Finish and wait while the 

Suitability Wizard creates all the 
necessary analysis components and 

completes processing. 

Viewing the results of your analysis 
One way to view your results is to open the Parcels attribute table (right-click on the layer name in the ArcMap 

Table of Contents and then click Open Attribute Table) and inspect the new field values.  You’ll note that the 
Suitability attribute (on the far right of the table) now has values between 0 (least suitable) and 100 (most 

suitable). 

A more graphical way to view your suitability results is to adjust the symbology for your Parcels layer. 

1. From the ArcMap Table of Contents, double-click the Parcels layer in the active scenario to open the 

Layer Properties dialog.  From there, select the Symbology tab. 
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2. In the left-hand list, select Quantities  Graduated colors.  Next, use the Value drop-down list to 
select the Suitability field.  Choose a color ramp and a number of classes that meet your preference and 

click OK.  Your map should now be symbolized by the results of your suitability.   

 
 

 

In the above example, the bright green represents the most suitable areas and the red the least suitable 
according to the three factors in your suitability measurement.  (Your map may 

look a little different from this one depending on which layers you are displaying 

and other factors.) 
 

3. Switch the active scenario using the drop-down list on the 360 Analysis tab to 
view the Proposal B. (You may need to turn it on via the Scenario 360 drop-

down then View  Scenario 360 Dockable Window.) 

4. Now you will explore the effects of changing the relative weight of and including or excluding each 

suitability factor.  Open the Assumptions window by clicking the Assumptions button on the 

Scenario 360 analysis tab. 
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5. Use the slider bars to adjust the weights associated with the three factors driving your suitability analysis 
(i.e., Well Proximity, Habitat Overlap and Slope), then click the Apply Assumption Changes button 

.  Also change the Yes/No assumptions for the three factors to include or exclude the factor in the 

Suitability calculation, then click the Apply Assumption Changes  button. The suitability results on the 

map will change dynamically based on your new settings.  If you get some white parcels it means that their 
score is outside the range ArcMap first detected when you set up symbology.  Return to the symbology 

window from Step 1 by double clicking Parcels on the Table of Contents, under Range click on 100.000000, 
and change it to 101.  

 

Now you can easily see which parcels score highest and lowest based on the criteria you used. Take a moment to 
compare your colored parcels map with the three layers used in your suitability factors: Water Wells, Elk 

Grazing Habitat and Slope. Do the results make sense based on your Assumption changes? 

Completing your suitability analysis 

Once you finish reviewing your suitability results, make sure the slider bar values of your Suitability 

Assumptions are set to any interesting set of non-zero values.  If the Apply Assumption Changes  button   

is active (i.e., the checkmark icon appears green), click it to apply the current assumption values to your analysis.  

This ensures your Suitability measure contains varied results (which will be used later when you use these 
results to drive your TimeScope analysis). 

Creating a Saved View 

You may want to return to your current state later, so create a Saved View that will keep track of your current 
display settings and layer symbology.  Saved Views keep track of which windows are open, which layers are on, 

and the map extent.  They do not keep track of your current assumption settings. 

1. On the Scenario 360 Toolbar, click the Saved Views   button. 

2. Click the New Saved View  button. 

3. When prompted, overwrite the default name “New View” with “My Suitability Analysis.”  

4. Check the box labeled Save layer symbology for the selected layers: 
5. Check on all the boxes in the list by holding down the Ctrl key on your keyboard and clicking on any 

one of them. 
6. Click OK. 

7. Close the Saved Views window. 
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Scenario 360 Sketch Tools and Land-Use Designer 
In this section, you will sketch a new land-use plan and measure its impacts.  You will create land-use styles with 

the Land-Use Designer, then “paint” land areas with particular land-use models using Sketch Tools and see the 
resulting impacts. As a refinement, you will learn how to create or modify land-use models and sketch styles on 

your own.  Finally, you will learn to “clone” an existing feature along with all of its land-use characteristics.   
 

You will continue working with the Sunny Vista dataset, so now might be a good time to save. Go to File | Save 

to save your work so far. 
 

Opening and setting up the data  
1. Make sure that Proposal B is still the Active Scenario by checking the Scenario 360 Analysis Work Panel, 

Scenario 360 Analysis, Active Scenario Drop-down. 
2. To make it easier to see what you are doing, make the following layers active by clicking on the boxes so 

that check marks appear: 
- Roads 

- Streams 

- Ponds 
- Parcels 

- Aerial Image 
Turn off the other layers for now. 

 
 

Starting the Land Use Designer and 
Scenario Sketch Tools 

1. Start the Land Use Designer by going to 

the Scenario 360 drop-down and 
selecting Tools | Land Use Designer 

. 

2. At the top of the Land Use Designer, 

select the land use layer Parcels.  
3. Look at the list of predefined land use 

models that are available for you to use.  

For this exercise, deselect all but the 
following models: 
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- LU Commercial 
- LU Mixed Use 

- LU Res Med Density 
The “LU” in front of each name labels it as a predefined “Land Use” model. 

      5.  Click Run.  

 
Based on your settings, the Land Use Designer will create three land use models you can use on your new layer.  

Each model contains a name and then several attributes appropriate to that land use, such as building densities 
and resource utilization rates. 

 
 

Applying Land Use Styles Using Scenario Sketch Tools 
1. By default, closing the Land Use Designer will automatically start an edit session on the Proposed Land 

Use layer in Proposal B.  If it does not, you can start editing by clicking on Start Edit   on the 360 

Analysis tab. This will make many of the Sketch functions active. 
2. When editing starts, ArcMap should automatically open the Editor toolbar and the Create Features 

window. Find the ArcMap Editor toolbar on your screen.  (You may need to turn it on via Customize  

Toolbars  Editor.)  Find the Create Features window (You may need to open it by clicking on the 

Create Features button on the ArcMap Editor toolbar.) 
3. The styles listed for the Parcels layer in the Create Features window were created by the Land Use 

Designer. To begin with, our map is like a blank canvas. To apply land use styles to the map, first you 

need to click on the style you would like to use under Parcels in the Create Features window. 
4. At the bottom of the Create Features window are Construction Tools to create data. Select the Painter 

Tool  (you may need to expand the Construction Tools list by dragging the window edge upward to 

see the full list of tools). 

5. You are now ready to paint!  Move the paintbrush cursor to the map and either click or click and drag the 
cursor over a polygon or series of polygons in the Parcels layer that you would like to designate with a 

chosen use.  After a few seconds of processing, the polygon will change color, indicating your new style 
has been applied.  Use the same procedure to paint the other polygons in your layer, alternating to other 

uses when desired. You have just “applied” styles to the Parcel polygons.  Note that styles are tied to 

particular layers; you can’t apply styles from one layer to another.    
6. To apply styles to a larger area, use the following technique.  Make sure a land use style is selected 

under Parcels in Create Features and that the Painter tool is chosen under construction tools. Draw a 
polygon on the map that covers all or at least part of every parcel you want to paint with a particular land 

use. To do so, hold down the Ctrl key while clicking polygon corners on the map. Double-click once you 
want to apply the polygon. All features intersecting the polygon will now take on the chosen land use. 

 

When finished, stop editing using the Stop Edit  button and choose to Save edits when prompted.  
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Viewing Land Use Designer Impacts 
The Land Use Designer created many new dynamic attributes (formula-driven fields) in your Proposed Land 

Use layer.  When you painted the map, particular values were assigned to these fields.  
 

1. You can see the new attributes and their values by opening the layer’s 
attribute table:  right-click on the Parcels Layer in the Table of Context and choose 

“Open Attribute Table.”  Review the many attributes the Land Use Designer created 

to define land uses and impacts. Close the table once you are done reviewing. 
 

The Land Use Designer also set up a number of summary calculations, or “indicators,” 
based on the feature attribute values.   

2. You can see some of these results by clicking on the Charts   icon in the 
Scenario 360 Content  360 Analysis task pane to open up the charts view.  Ensure 

that the charts drop-down is set to “Active (Proposal B)” at the top of the charts 
window (If it is already set to Active (Proposal B) you may need to refresh the charts 

by clicking it again).  Scroll through the charts to find ones whose name contains “LU.” 
 

3. Experiment by starting to edit again and then using the paint brush tool to 
modify the land use style of some of your polygons.  You will notice that the chart 

values update in response to your new proposed plan. 
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Advanced/Optional:  Customizing Land Use Design Models 
This section contains advanced topics.  You can skip ahead to the Setting up Build-Out Analysis section if desired 

without losing continuity. 
 

You can modify the pre-defined land-use models you have just used, or you can create entirely new ones.  For 

this exercise you will change some settings in the “LU Res Med Density” style.   
1. Make sure that at least one of your land-use polygons is painted with the LU Res Med Density style.   

2. Ensure that you have Stopped Editing. 
3. Note the current values, as shown in the charts, for the indicators “Sum of LU Children” and “Sum of LU 

Residents.”   

4. Reopen the Land Use Designer by clicking on the Land Use Designer  on the Decision Tools toolbar 

and make sure the active land use layer is Parcels. 

5. Highlight the LU Res Medium Density line in the table and click on the Model Properties  button on 
the tool bar in the Land Use Designer window.  This opens up the Properties window for that model.  

You may want to take a few minutes to explore the various tabs. 
6. On the Building Info tab, change the Dwelling Units per Area from 4 to 10.  This increases the 

proposed density and will therefore increase the number of houses and all their impacts. 
7. On the Per Dwelling Unit tab, change the LU Children per DU value from 0.6 to 0.8.  This setting 

changes the average number of school-aged children in each house for polygons designated as LU Res 

Med Density. 
8. Click Finish to close the model properties wizard. 

9. Ensure the LU Res Med Density style box is still checked on. 
10. Apply Changes to update your analysis. 

11. Compare your new values for “Sum of LU Children” and “Sum of LU Residents” to your previous ones.  

You will see that they have updated on the basis of the density and per-dwelling unit changes you made. 
 

In this exercise you learned how to use predefined land-use models and how to change existing settings.  
There are many more capabilities in the Land-Use Designer, including adding additional attributes to models 

and creating new models from scratch.  Refer to the Scenario 360 Help for details. 

 

Setting up a build-out analysis  

While the Land Use Designer gives you quick estimates of land-

use impacts from sketched land use options, build-out provides 
a more sophisticated, in-depth analysis of how much building 

the land can support given the many details of land-use or 
zoning regulations. The Scenario 360 build-out analysis tool 

(the Build-Out Wizard) automates the entire build-out process.  
It guides you through the choices and selections that will form 

the basis of your build-out analysis.  In the fictional example of 

Sunny Vista, you will run a build-out analysis on a proposed 
land use layer just west of the parcels you’ve been analyzing 

with Land Use Designer. It has some features where we’ve 
already defined land use types and you’ll use the build-out 

wizard to define their development potential. Locate the 

Proposed Land Use layer in the table of contents, make sure it’s 
turned on and take note of the land use types:  

• Commercial 

• Mixed Use 

• Res Med Density 
 

 

 

 

 

 

 

The land-use rules for this analysis are included in the table below.  In this tutorial, you will be walked through 
entering this basic information and a few other rules into the Build-Out Wizard to run a numeric and spatial build-

Commercial Mixed Use 

Res Med Density 

Res Med Density 
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out analysis.  For a more detailed breakdown of the steps involved in creating and running a build-out analysis, 

please see Tutorial 5 – Setting up and running a build-out analysis. 

 

Land-Use 
Designation 

Dwelling 
Units 

Floor Area 

Commercial 0 2 FAR 

Mixed Use 1 DU/acre 1 FAR 

Res Med Density 4 DU/acre 0 

 

Preparing the Data 

To begin, make sure Proposal B is the active scenario by selecting it from the drop-down list on the 360 

Analysis tab. Make sure Proposed Land Uses is checked on in the table of contents. 

 

Setting up a numeric build-out analysis 

For a numeric build-out analysis, the Build-Out Wizard will calculate the estimated building capacity (in numbers) 
for each parcel.  Note that at any time while you’re working with this Wizard, you may exit and retain your 

entered information by clicking the Save and Exit button at the bottom of the wizard. 

1. Open the Build-Out Wizard.  You can access the Build-Out Wizard using the Scenario 360 toolbar.  Click 

the Scenario 360 drop-down list and select Tools  Build-Out Wizard.  (For now, do not click the 

Advanced button, which launches a more detailed version of the Wizard.  You can return to it later if 
desired.)  

2. Click the Numeric button.   
 

 

Specifying land-use information 

At the prompts on the first page of the numeric build-out, specify the following information: 

1. On the Specify Land-Use 
Layer screen, ensure that 

Proposed Land Uses is 

selected as the layer 
containing land use 

information. 

2. The attribute specifying 

land-use designation 

should read Land Use. 

3. Preview the land-use 

designations in the field 
provided then click Next. 

 

Setting up density rules 

Density is an indication of the number of buildings per unit area.  For residential polygons, density is often 

provided in dwelling units per area (e.g., 2 units/acre), number of dwelling units, or minimum lot size per area.  
For non-residential polygons, density is usually provided in floor area (e.g., 10,000 sq. ft.) or by using a floor area 

ratio (FAR).  For this exercise: 
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1. Either type or click and select from a provided drop-down list to fill in the fields with the information 
shown in the image below: 

  

 

2. Click Next. 
 

Mixed-Use Percentages 

Because at least one of your land-use types mixes residential and commercial uses (i.e., has dwelling units and 
commercial floor area), the next screen, Mixed-Use Percentages, appears and gives you the option to specify 

more details.  You may ignore this screen for now, accepting the default values and clicking Next. 
 

Using efficiency factors 

Efficiency factors adjust density values to reflect common density losses, such as area for future roads and open 
space, which may not be easy to represent spatially. They are useful for areas where the Code or Comprehensive 

Plan allows for development densities that might not be practically achieved. They are entered as a percentage 

where 100% means complete efficiency (no density lost), and 0% means no buildings will be estimated for that 
land use.  On the Efficiency screen, leave the default setting of Assume 100% efficiency checked and click 

Next. 
 

Specifying constraints to development and existing buildings 

Land-use regulations may prohibit building in certain areas, such as on rights-of-way or on protected lands such 
as endangered species habitat.  In addition, some areas may be impractical for building because they are on too 

steep a slope or under water.  If your analysis contains layers representing these unbuildable areas, which the 
wizard calls “constraint layers,” you can specify them here.  For this example, highlight the layer called “Elk 

Grazing Habitat” and then click the right green arrow to move it into the list of Constraint Layers.   
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Some land-use regulations also specify a minimum lot size for new construction, but we will ignore that option 
here.  Click Next. 

 

Existing Buildings 

In any plan you may have development within the plan area which is already developed. This screen allows you 

to incorporate a point layer for existing buildings and specify the amount of development for residential and 
commercial uses. Since our simple plan area is vacant, you can click Next to move past the Existing Buildings 

screen. 
 

Completing the numeric build-out phase 

You are now finished setting up the numeric phase of the build-out analysis.  On the End of Numeric Phase 
Wizard screen, select Spatial to continue on to spatial build-out set up or click Next. 

Setting up a spatial build-out analysis 
Spatial build-out places potential new building points on a 2D map.  It converts the numeric building counts into 
points representing individual structures, and it attempts (via computerized trial and error) to place those 

structures on the land without violating a set of spatial rules about where buildings can go.  In some cases, it 
finds it cannot place all the buildings specified by numeric build-out because of the geometry of land-use areas 

and buildings.  For example, an oddly shaped lot may theoretically have enough total area for 2 buildings, but 

because of setback rules or minimum separation distances, it only may fit 1 unit.  In this case, the number of 
“spatial” buildings is less than the number of “numeric” buildings, providing a more refined estimate of build-out 

capacity.  You must first run a numeric build-out analysis (to get the numeric building counts) if you wish to run a 
spatial build-out analysis. 

 

Specifying building separation distances and choosing a layout pattern 

You have control over how far apart buildings need to be, whether the spatial build-out building points are 

distributed in a random or grid pattern, and if you want the points to follow a road layer.   

1. Make sure the units drop-down list under Minimum Separation Distance has feet selected. 

2. Make sure the units dropdown list under Setback has feet selected. 

3. Using the information in the image below, type or click and select from a provided drop-down list to fill in 
the Minimum Separation, Layout Pattern, Road or Line Layer, and Setback fields. 

   

4. Click Next. 

 

Running a spatial build-out analysis 

1. Move the slider bar to 100.  This is a small study area and will not take a long time to process.  

2. Click Finish.  If it is showing, select the Overwrite the current results option.  (This option doesn’t 
appear the first time you run a build-out.)  
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3. Make sure that only Numeric and Spatial are 
selected (they have a checkmark next to them) and 

click Run Build-Out. 

You can monitor the progress of the processing by watching 

the status bar on your screen, this can take several minutes. 

When the process completes, locate the Build-Out layer group 
in the Table of Contents, including the Buildable Area layer 

and the Buildings layer. You can expand the group and turn 
on layers if they are not currently checked on in the table of 

contents. You can also move the Build-Out group in your table 
of contents by dragging the group heading, Build-Out, to 

below ponds in the Table of Contents.  Notice that the 

Buildable Area layer is just like the original Proposed Land 
Use layer except that the Elk Grazing Habitat constraint layer 

has been cut out or “clipped.” (It may help to turn off the 
Proposed Land Use layer display.) It is also color-coded to 

illustrate the land-use designation for each area using the 

same color coding from your original Proposed Land Use 
layer.   

If you open the attribute table for Buildable Area (right-click on the Buildable Area layer in the table of contents 
and select Open Attribute Table in the list), you will see several fields containing useful information. The Buildings 

layer shows building points placed by spatial build-out.  Note that none of the buildings lies on the constrained 
area, and notice how all the Mixed Use buildings are aligned along a roadway the same distance from the nearest 

road.  

For more details on your build-out analysis, open the Build-Out Report by clicking the List Reports  button on 
the Scenario 360 toolbar and then clicking on the name of your build-out report.  

Are buildings missing?  If your Mixed Use polygons are farther than 100 feet from the nearest road, the 
Wizard will not place any buildings because you specified a 100-foot setback.  Try re-opening the wizard, 

changing the setback, and re-running the Build-Out.  (The ability to run the analysis many times with slight 

changes is one of the great advantages of the Build-Out Wizard.)  There will only be a single commercial building 
on each feature allowing commercial use because in this set up you did not specify how big each building should 

be.  If you check the attribute table or the build-out report, you will see the number of commercial square feet is 
large.  You can specify commercial building sizes using the Advanced wizard.   

Setting up a TimeScope analysis 

The Scenario 360 TimeScope decision tool helps 
you look at changes over time by allowing you to 

specify the rate and order that features will be 
built.  The Wizard prompts you to enter data and 

assumptions that create a TimeScope Time 

variable assumption and apply TimeScope to one or 
more dynamic layers in your analysis.  In this 

tutorial, you will be applying a TimeScope analysis 
to both the 3D Buildings layer of sketched 

footprints as well as the Buildings layer generated 

in the Build-Out analysis above.  

For clarity, turn on (display) the 3D Buildings 

layer and Parcels layer in the Table of Contents, 
and turn off the Buildable Area layer.  You can 

access the TimeScope Wizard using the Scenario 
360 toolbar.  Click the Scenario 360 drop-down 

list and select Tools  TimeScope. The initial 

setup screen displays all layers in your analysis, 
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marking the dynamic layers with a Dynamic Layer  icon and reference (non-dynamic) layers with a reference 

icon.  

 
As you will see after you do the next exercise, if TimeScope has been applied to a layer, its icon changes to a 

TimeScope  icon.  The layer's start date, end date, build rate, and build order are displayed for informational 

purposes.  To change any of these, edit the layer using the Edit  button or double-click on the layer name.  

The build order indicated refers to features within that layer, not to that layer’s order with respect to any other 
layers. 

 

Setting up TimeScope for a layer 

The first time you set up TimeScope in an analysis, a 

TimeScope Time assumption will be created.  You 
can see its default settings on the opening screen.  

You may leave these defaults in place.  In this 

tutorial, you will be using this assumption for the 3D 
Buildings layer and the Build-Out Buildings layer.   

1. Double-click on 3D Buildings in the 
TimeScope layer list. 

2. The Specify Date Range screen is used to 
designate the start and end dates for the 

particular layer you are working on.  In this 

case, accept the defaults and click Next. 

3. The Build Rate screen is used to specify 

how quickly additional features are built as 
TimeScope Time moves forward.  Select 

Exponential growth as the Rate Type 

then type in the following for Rate 
Settings: 

• Use one rate for all scenarios 

• Growth rate = 10% per year 

• Initial features = 15 (meaning 15 new 

buildings at the start of growth) 

• Existing features = 0 
Click Next. 

4. The Build Order screen specifies the sequence in which features are built as TimeScope Time moves 
forward.  Select Phase Layer as the Select Order Type.  For the Order Settings, select the Parcels 

layer and the TimeScope Suitability attribute as shown in the image below.  This attribute is the one 

that was created by the Suitability decision tool when you clicked “Create a TimeScope phase attribute.”  
These settings will cause buildings to appear in the most "suitable" locations first as time moves forward.  

(Optional:  To refresh your memory on suitable locations, you can look at the Saved View you made 
earlier using Scenario 360 Toolbar > Open or Save a View > Highlight My Suitability Analysis in the list > 
Load View.  This may turn off your 3D Buildings layer; if so, just turn it back on.   If you didn’t happen to 
create a TimeScope Suitability attribute earlier, don’t worry.  Just choose Random order for this exercise.) 
Click Next. 

5. If desired, TimeScope can automatically keep track of how many features it has built during each time 
increment.  The results can be reported as a set of indicators or in a table.  The indicators can then be 

plotted in sequence as a line chart that shows growth as a function of time.  For this step, we’re not 
going to track feature totals.  So, at the TimeScope Feature Counting Wizard screen, accept the 

defaults and click Next. 

6. At the Finished page, accept the defaults and click Finish to exit the Wizard and run the TimeScope 
analysis. 
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7. Once it completes, you will see the  icon next to the 3D Buildings layer. Close the wizard by clicking on 

the red X in the upper right corner. 

 

Note that like other decision tools, TimeScope does not automatically re-run when you make changes to your 

analysis.  When you are in analysis mode, changing the TimeScope Time variable assumption will cause 
automatic analysis updates in the same way that other assumption changes cause updates.  However, if you edit 

the map, modify formulas, or make other analysis changes, they will not be reflected in TimeScope until you re-

run it. 

Experiment with the TimeScope Time assumption 

1. Open the Assumptions window by clicking the Assumptions  button on the Scenario 360 toolbar.   

2. Find the TimeScope Time assumption slider bar.  If it is not showing, you can expand the window by 

dragging the bottom edge down. You can also click the Organize  button, place a check next to 

TimeScope Time in the list, and click OK. 

3. Adjust the slider bar for the assumption TimeScope Time to a new position and then click the Apply 

Assumption Changes  button.  You will observe the pattern of mapped buildings change as the year 

changes.  The growth of buildings in this example corresponds to the Suitability measure you generated 
earlier:  the first buildings will be built in the parcels with the highest Suitability rating and the last built in 

the parcels with the lowest Suitability rating.  Remember that these suitability ratings are ones you set up 
in an earlier exercise and probably aren’t very realistic for representing actual build order.  In your own 

work, you can set up build orders that make more sense to you based on factors you think are important. 

 

Add TimeScope to another layer 

If it is not on already, turn on the Buildings layer in the Build Out group in the Table of Contents. 

1. Open the TimeScope Wizard again and double-click the Buildings layer that was created by Build-Out. 
2. Accept the default Date Range. 

3. Under Build Rate, choose Linear growth and set the Rate to 10 per year. 
4. Under Build Order, choose Proximity to a layer and specify the layer Ponds. 

5. Step through the rest of the wizard accepting all defaults and click Finish. 

Experiment some more with the TimeScope Time assumption, noting how 3D Buildings and Buildings both appear 
and disappear as the date changes.  Are they being “built” when you expect? 

Setting up a Common Impacts analysis 

The Scenario 360 Common Impacts decision tool, or Common Impacts wizard, automatically generates several 
commonly used impact indicators associated with growth and development over time.  Up to twelve standard 

impacts are generated solely on the basis of a “buildings” layer you specify.  Three special impacts can be 
generated if you provide additional information or layers to use for reference.  All impacts are optional.   

For this exercise, you will start by generating the standard set of Common Impacts.  The special impacts will 
be skipped in this exercise. 

1. You can access the Common Impacts Wizard using the Scenario 360 toolbar.  Click the Scenario 360 

drop-down list and select Tools  Common Impacts Wizard. 

2. Accept the default selections on the first page and click Next. 

3. On the second page, the Buildings layer should be selected by default, along with the Dwelling Units 
and Floor Area fields within this layer.  These fields are the ones generated by build-out and they are 

used by Common Impacts by default if they are present.  If you had not run a Build-Out analysis prior to 

running this tool, you could specify an appropriate layer to represent your buildings.  If fields equating to 
dwelling units per building and/or floor area per building were unavailable, you could type in a number 

for either option. 
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4. Click the Next button then click the Next button again.  

5. The Finished page lists all the assumptions and charts that will be created by the Wizard and asks you 

some questions about which windows you would like to have open once the Wizard completes its 
analysis.  Uncheck the box labeled “open common impacts assumptions window after window 

closes” and then click Finish to run the analysis. 
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Examining the Common Impacts results 

The Common Impacts charts display the results of the analysis you just ran for each scenario. 

1. Right click on the chart titled Annual CO Auto Emissions and select View Chart Assumptions from 

the pop-up menu. 

 

 

 

 

 

 

 

 

 

 

2. This opens the Assumptions window and displays only the assumptions that directly impact Annual CO 

Auto Emissions.  These assumptions indicate the base values behind the calculations that were 
performed.  

Click the name next to the slider for any one of these assumptions and the associated Assumption 
Information dialog will open.  This dialog contains a description of the source we used for that 

assumption’s default value. 

         
 

 
 

 
                                                 

 

 

 

 

 

 

 

 

 

3. Move the Passenger Car Fuel Efficiency slider bar to a new position and then click the Apply 

Assumption Changes  button.  Note how the values for the various Annual Auto Emissions charts 

changed accordingly.  This is a good reminder that these assumption values are intentionally variable.  

They will change over time and from place to place.  Make sure to research your own settings thoroughly 

to identify corresponding Common Impacts assumption values that will make most sense for your 
individual analyses. 

4. Move the TimeScope Time slider bar to a new position and then click the Apply Assumption 
Changes button.  You should see the values of all the charts for your current scenario change as 
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the set of built buildings is updated. 
 

Reviewing the Common Impacts report 

The Common Impacts Wizard generates a report called Common Impacts Report each time it runs.  To access 

this report, click the Reports  button on the Scenario 360 toolbar and then double-click the report of 

interest to view it in your internet browser.  The report is in HTML format.  This allows you to click on links to 
access more information. 

 
To get an updated report on Common Impacts results after you have changed any assumption settings, click the 

New Report  button on the Reports  form setup and select the Common Impacts report type. 

 

Note that when you re-run the Common Impacts wizard, previous common impacts reports are overwritten.  To 
save the report from a particular run, rename your old report before re-running the Wizard.  

 

Active content in reports 

Scenario 360 reports may contain Active Content.   

 

NOTE:  Active content uses Javascript code that may be blocked by your browser as a security precaution, so 
the active content in the report may be disabled when you open a report.  You can usually tell when a browser is 

blocking active content by looking for a message at the top of your browser window.  For example, Internet 
Explorer 8 displays a message like this at the top of the browser window: 

 

 
 

To temporarily enable active content on this report only, right-click on the information bar and choose Allow 
blocked content.  You will need to perform this step each time you open the report. 

 
Active content includes buttons that allow you to expand or collapse individual sections of the report, and 

information boxes that appear when you hover your mouse over a chart.   

1. Click the Expand  icon next to a heading to see the full contents of that section.  Click the Collapse

 icon to show only the heading. You can expand or collapse all sections at once by clicking Expand 

All or Collapse All links at the bottom of the report. 

2. To view chart, indicator, assumption and/or attribute descriptions, hover your mouse over the chart or 

component name in the listed tables.  

 
To persistently enable active content for all files stored on your computer (such as these reports), you can 

change your browser’s settings.   See Using the Common Impacts Report in the Scenario 360 Help for 
detailed instructions. 

 

To view the printer friendly version of the report, click the Printer Friendly button at the top of the report page.  
This will open a new window with smaller chart images better suited for printing.  Note that all the collapsible 

sections in the report are open by default.  If there is a report section you do not wish to print, simply click the 

Collapse  icon for that section and it will be removed from the printed document.  Once you are satisfied with 
the content you wish to print, click the Send to Printer button at the top of the printer friendly report. 
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Custom Impacts analysis 
The Custom Impacts Wizard provides an easy way to 

set up certain kinds of analysis that are not included in 
Common Impacts or the Land Use Designer.  For more 

specialized analyses you can set up everything yourself 
using 360 Setup tools, but Custom Impacts provides an 

intermediate level of sophistication.  You can access 

the Custom Impacts Wizard using the Scenario 360 
toolbar.  Click the Scenario 360 drop-down list and 

select Tools  Custom Impacts Wizard.  
 

There are several different kinds of impact models 

available; for this exercise you’ll create two. 
 

Count buildings near wildlife corridors 
1. On the Welcome screen, choose to Count… 

Features based on location and click Next. 
2. On the Settings screen, specify 

- the layer containing features to be counted is Buildings 

- the layer to be near (second radio button) is Wildlife Corridors 
- for maximum distance considered near, use a variable assumption 

3. In this case the assumption doesn’t exist yet, so make one by clicking New Assumption. 
4. Set up the assumption as follows: 

- On the Properties tab, Name:  Safe Distance 

- Accept all other defaults and click on the Valid Values tab 
- Set Min: 0     Default: 100   Max: 1000    Units: feet 
- Accept all other defaults and click OK. 

 

5. Back on the Settings screen, pick Safe Distance in the drop-down box for the assumption. 
6. Click Next to review the components that will be used, then Finish. 

7. Look at the charts to find Buildings Near Wildlife Corridors.  This gives the default result. 

8. Open the Assumption  list from the Scenario 360 toolbar.  Use the Organize  button to find and 

display the Safe Distance assumption, which will be in the Common Impacts category. 
9. Experiment with changes to Safe Distance by moving the slider bar and then clicking    Apply 

Changes .  Notice how Buildings Near Wildlife Corridors changes.  Does it make sense? 

 

Count parcels by land-use type 

1. On the Custom Impacts Welcome screen, choose to Classify and Count features by attribute value.  
Click Next. 

2. On the Settings screen, specify: 
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- Layer containing features to be counted is Parcels 
- Classify automatically 

- Attribute upon which classification is based is LU Land Use Name  
3. Click Next and Finish.   

4. Look at the new chart called Count of LU Land Use Name.  It shows the proportion of parcels of each 

land-use type.  To see exact numbers, right-click the chart, choose Chart Details, and change the chart 
type from Pie to Bar. 

Congratulations – you have completed Tutorial 1 
This concludes the tutorial for Integrated analysis with decision tools.  You have run a suitability analysis, used 
the Land Use Designer to prepare sketch style paints for a land use plan, completed a build-out analysis, 

generated TimeScope projections for buildings based upon the suitability analysis and spatial characteristics, 
generated some common and custom impacts based upon the buildings layer and studied the combined results.  

We recommend you look back through the steps to review the Scenario 360 features you used and reflect on the 
overall approach to the analysis, focusing more on the functions than on the exact buttons and steps.    



25 

Tutorial 2 – Explore an existing scenario 

This tutorial walks you through exploration of an existing analysis. In this fictional example, a rural mountain 
valley is being considered for development.  Two alternatives, or “scenarios”, are being considered: a traditional 

large-lot residential housing development, and a village-style compact development with mixed uses of residences 
and retail establishments.  Part of the analysis will compare road costs between the two scenarios. In addition, 

the analysis will study the suitability of building sites based on several factors: proximity to wetlands that cover 

part of the valley, proximity to a nesting site for a protected species of bird, and availability of water from water 
storage tanks that may or may not be at a high enough elevation to provide sufficient water pressure.   

 
The tutorial will also walk you through using Scenario 360 Sketch Tools to paint feature attributes to other 

features and to clone features.   
 

Once installed using the “Install the tutorial data” directions on page 1, you will find this analysis in the 

CVFiles\Communityville folder. 
 

In this exercise, you will learn to: 

• work with the ArcMap table of contents  

• use variable assumptions  

• view and use indicators and associated charts 

• view and change attributes  

• manipulate map features and layers 

• compare two scenarios 
 

Suitability and cost analysis of rural residential vs. village development 

This tutorial illustrates one of the many kinds of analyses that are possible with Scenario 360 - suitability analysis.  
In the fictional town of Communityville, some locations are considered appropriate for building (suitable), while 

others are not.  Some factors that might make a location unsuitable include being too close to a nesting site, 
lying in a wetland area, or having insufficient water pressure.  In this tutorial you will experiment with all three.  

 

Objective 

Compare and evaluate rural residential development and village-style development in a rural mountain valley. 

Issues 

• Site suitability 

• Road construction costs 

Constraints 

• Proximity to nesting location 

• Proximity to wetlands environmental area 

• Elevation of water storage tanks relative to dwelling units 

Starting the tutorial 
1. Start Scenario 360 by double-clicking on the Scenario 360 

icon on your desktop. 

2. On the Welcome to Scenario 360 window, click Open 
Existing Analysis. 

3. Browse to the CVFiles\Communityville file, click the file, and click 

OK. 
4. If you are asked whether to create indexes, answer yes. 

 
The tutorial analysis will load in Scenario 360 and display a fictional place 

called “Communityville.”  Communityville is a high mountain meadow site 

being considered for development. 
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Note:  If you are not seeing the data in the map view and red exclamation points are displayed next to 
your layers in the ArcMap table of contents, you probably installed your software in a non-standard 

location.  When you open a map, ArcMap looks for the data referenced by each layer in the map. If it 

can't find the data source for a particular layer, that layer won't be drawn.  It will display in the table of 
contents with a red exclamation mark next to its name and the check box next to the layer will be 

unavailable. 
 

If you know the new location of the data, you can repair the layer by doing the following: 

1. Right-click on the layer name, point to Data, and click Set Data Source. 
2. Navigate to the directory containing the correct data source file, click the file, then click Add.  

ArcMap will attempt to find all data (if it is located in the same folder). 

Working with ArcMap 
These tutorials assume that you are familiar with using ArcMap navigation tools.  
 

If you are unfamiliar with the ArcMap toolbar (shown below) and working with the map images, layers, and data 

sets, refer to the ArcMap help accessed via 
the ArcMap Help menu. 

 

You can size the extent shown in the map view using the Full Extent  or the Fixed Zoom Out  buttons. 

You may also use the Zoom In  or Zoom Out  tools, just point, click, and drag your cursor, encircling the 
desired area of the map to shrink or enlarge it.  You can refresh the map view by clicking the Refresh View 

button at the bottom left side of the map view. 

Working with toolbars in ArcMap 

Toolbars in ArcMap can be docked at the top, bottom, left, or right side of the ArcMap window. Alternatively, 

toolbars can float on the desktop while functioning as part of the application. When you dock a toolbar, it is 

ArcMap table of contents 

Scenario 360 toolbar 

360 Analysis and 
360 Setup tabs 

Active Scenario 

drop-down list 

Scenario 3D toolbar 
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moved and resized with the application window.  The Scenario 360 toolbar displays as a floating toolbar the first 
time you launch the Scenario 360 application. 

 

• To move a docked toolbar, click the move handle  and drag the toolbar to the new location. 

• To move a floating toolbar, click on the title bar and drag the toolbar to the new location.  Note: If you 
drag the toolbar to the edge of the program window, it becomes a docked toolbar. When you move one 

docked toolbar, this might affect the location and size of other toolbars on the same row. 

• To prevent a toolbar from docking, hold down the Ctrl key while dragging it. 

• You can close a floating toolbar by clicking the x in the upper right corner of the toolbar.  You can open 

or close toolbars by clicking the View menu, pointing to Toolbars, and then clicking next to the toolbar 
name you wish to open or close. 

 
You can learn what the toolbar buttons and menu commands do by positioning the mouse pointer over a button 

or menu command for a second or two.  The name of the item will then pop up in a small box. Simultaneously, a 

brief description will appear in the status bar at the bottom of the application window.  
 

The ArcMap table of contents 

Examine the ArcMap table of contents and the symbols representing the various features displayed on the map. 

 

 

The ArcMap map view 

On the map, note the wetlands area and the nesting location. The small green squares represent proposed 
dwelling units that would constitute a village-style development. The gray lines are roads. All of these features 

are “layered” over a .tif satellite image of the proposed development. You may toggle these features to change 

the display on the map by clicking on the check box to the left of the feature in the ArcMap table of contents. 
Take a few moments to toggle on and off some of the layers in the table of contents and practice using the zoom 

and extent tools. 
 

The active scenario is shown in bold 
in the table of contents.  You can 
select the active scenario from the 
Active Scenario drop-down list on 

the 360 Analysis tab. 

Data layers in Scenario 360 can be 
designated as dynamic or not (a 

dynamic layer is one that contains 
dynamic attributes).  You can 

distinguish dynamic layers from non-
dynamic layers in the ArcMap table of 
contents by the bold outline next to 

the data layer name. 

Click the  next to any layer or 
scenario in the table of contents to 

expand the table of contents. 

Toggle features on and off in the map view 
by placing or removing a check mark in the 

box next to the layer name. 



28 

 
 

 

Viewing charts 
Indicators are impact or performance measures that can reference 

datasets anywhere in a scenario.  They are used to provide an overall 
measurement and they apply to an entire scenario (as opposed to an 

attribute, which provides the individual characteristic of a map feature). 
Indicator values are automatically recalculated as you experiment with 

alternatives, and these values can be displayed in a chart. Indicators can 

help people choose alternatives that best match their objectives or 
desired outcomes.  For example, an indicator might be used to evaluate 

costs, revenues, average household size, "community benefit,” or total 
daily auto trips.  

 

There are three indicators set up for this tutorial: 

• Is suitable 

• Is not suitable 

• Road cost estimation 
 

Charts are dynamically linked to assumptions and indicators.  As changes 
are made in the analysis, chart displays will update automatically to 

reflect analysis results. Hatched areas on bar charts show the chart’s 
previous value.    Target lines may be included to demonstrate a 

particular goal or threshold.  Charts can contain a single analysis value or 

many values from the same scenario.  They can also display values from 
different scenarios for comparison. 

 

If the chart view is not open (see image right), click the View Charts 

button  on the Scenario 360 toolbar to display Road Cost and 
Suitability indicator charts.  The View Charts toolbar button works as 

a toggle button.  You can use it to toggle the chart view on and off.  The 

charts window can be resized and moved around the screen for 
comfortable viewing. You can choose which scenarios appear in the charts by using the drop-down box at the top 

of the charts window.   
 

 

 
 

 

The green squares represent 
proposed dwelling units that 
would make up a village-style 

development 
The grey lines 

represent roads 

TIF satellite image 
in background 

Wetlands area 

Nesting location 

Click to expand or 
contract the chart 
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Working with assumptions 
An assumption is a value that is used as input to an analysis.  They are often changeable, and they always apply 

to an entire scenario. Assumptions can be a way to express subjective inputs, such as how much weighting to 

give to a particular community value like open space or economic development. 
 

An assumption can be designated as a numeric value within a valid range (as might be displayed in a slider bar) 
or as a choice (number, text, or Boolean – yes/no) associated with a defined set of valid values.  A numeric 

assumption can be any number, rate, or standard (number of stories, gallons per household, cost per mile, % 

discount).  “Choice” assumptions may represent a type (dirt, gravel, paved) or time frame (1990, 2000, 2010).  
 

Assumptions can be referenced in any analysis formula.  All analysis calculations that depend on an assumption 
value will be automatically recomputed if you modify that assumption value.  

 
Variable assumptions 

A variable assumption is an input to the analysis that might change as part of the analysis, such as the current 

interest rate, seasonal resource consumption values, residential density, or survey results.  A variable assumption 
may be altered during analysis using a slider bar, choice button, or drop-down list (see image below), and it can 

vary across scenarios.  Slider bars are excellent for setting relative weighting factors.  
 

Fixed assumptions 

A fixed assumption is an input to the analysis that will not likely change, such as the municipal water supply.  A 
fixed assumption value cannot be altered and has the same value across all scenarios. 

 

Changing assumptions for the acceptable distance to the nesting area 

You will work with variable assumptions to change the minimum acceptable distance between the dwelling units 

and the nest of a protected species of bird. When the assumption was originally setup, the designers of the 
analysis set the default location to 300 feet. At that setting, all 72 proposed dwelling units in the Village scenario 

were found to be in suitable locations, as you can see from the map below (all building locations are colored 
green) and from the chart (72 suitable locations, 0 unsuitable ones in the Village scenario).  (To make the chart 

show both scenarios, choose “Compare by All Scenarios” at the top of the charts window.) 

 

  
 
Working with the variable assumption Bird Nest Setback, you will change the assumption and dynamically update 

the suitability factor for the building locations in this proposed subdivision.  These will be displayed on your map 
and chart.  Start by zooming in or out to a map extent that lets you clearly see the individual buildings in the 

proposed village.  Make sure all layers except “elevation” are visible (place a check in the box next to their name 

in the ArcMap table of contents).  
 

1. To begin, make sure Village is the active scenario by selecting it from the drop-down list on the 360 
Analysis tab, if it isn’t already.   
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2. Click the Assumptions  button on the 360 Analysis tab to display the graphical assumptions view.  

Note that the Scenario drop-down list is set to display assumptions for the active scenario (Village). 

 
 

 
3. You are going to change the acceptable distance from building locations to the nesting site.  In this case, 

you want to explore suitability for building locations located no closer than 600 feet from the nesting site.  
Click and drag the Bird Nest Setback assumption slider bar to change the assumption value to 600 feet 

from the nesting site. 

-OR- 
Click the increase   or decrease   buttons to change assumption value to 600 feet from the nesting 

site. 

4. Click the Apply Assumption Changes  button to apply your changes. Scenario 360 will update the 

scenario and dynamically change the suitability (from green to red) of all dwelling units located within 
600 map units (which are set in feet) of the nesting site. Buildings in unsuitable locations turn from green 

to red. Notice the chart values showing number of suitable and unsuitable locations in the Village 

scenario change as well. Scenario 360 will display the previous value (before the assumption change) 
with gray diagonal lines.  Remember, if you need to refresh the map view, click the Refresh View 

button  at the bottom left side of the map view.   
 

  
 

 

5. On the Assumptions display, click the Tabular tab. You can also use this dialog box to enter numbers 
and change assumptions. Notice that the table shows assumptions for both scenarios (Village and Rural) 

side by side.  
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Depending on the type of values for the assumptions, you can type directly in the fields or select from a 

drop-down list.  
 

6. Type 400 in the Bird Nest Setback for the Village scenario and click the Apply Assumption 

Changes  button.  Scenario 360 will update the scenario and dynamically change the suitability (back 

to green from red) of all dwelling units located farther than 400 feet of the nesting site. Notice the chart 
values change as well. 

7. When you are finished, close the Assumptions window and click No when asked whether you want to 
save assumption changes. 

 

Changing assumptions to prohibit building on wetlands 

Now you will work with variable assumptions to change a yes/no assumption about whether building is allowed in 

the wetlands area. When the assumption was originally setup, the designers of the analysis set the default to No  

- therefore allowing (not prohibiting) construction in wetlands. This resulted in all 72 proposed dwelling units in 
the Village scenario were found to be in suitable locations. Working with the variable assumption Prohibit 

Building in Wetlands?, you will change the assumption and dynamically update the suitability factor for the 
building locations in this proposed subdivision.  

1. Click the Assumptions  button on the 360 Analysis tab then click the Graphical tab to display the 

graphical assumptions view.  Note that the Scenario drop-down list is set to display assumptions for the 

active scenario (Village). 

2. Click the Yes radio button next to the Prohibit Building in Wetlands? assumption and click the Apply 

Assumption Changes  button. Scenario 360 will update the scenario and dynamically change the 

suitability (from green to red) of all dwelling units located on or intersecting the wetland area. Notice also 
the chart values change as well.   

 

    
3. When you are finished, close the Assumptions window and click No when asked whether you want to 

save assumption changes. 
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Working with the ArcMap map view 
When analyzing alternative scenarios, you may want to consider moving features on a map. For example, you 

may want to move a building further away from a highway or protected area. In this tutorial you have designated 

a nesting area for a protected species of bird. In this exercise, you will move a building in the Rural scenario 
away from the nesting area to make it a suitable location for building.   

 
You can move features by specifying delta, x, y coordinates, dragging the feature, or rotating the feature. In this 

exercise, you will move a building by dragging it to a new location. Dragging is the easiest way to move a feature 

if you know the general location; for more precise movement, use the delta, x, y coordinates method (instruction 
available in the ArcMap help). 

Moving features in the map view to change suitability 

1. Click the Active Scenario drop-down menu on the 360 Analysis tab and select Rural as the active 

scenario.  

2. Click the ArcMap List by Selection  button (located at the top of the ArcMap interface).  This will 

open a list of available layers that lets you choose which layers you want to select when editing. In this 
example, you want to select a building by drawing a box around it but you do not want to select the road 

or any of the features next to it. To avoid selecting multiple features, click on all layers with a 

Selectable symbol except for the Proposed Buildings layer.  All layers other than Proposed 

Buildings should have a Non Selectable  symbol. 

 

3. Click the Start Scenario Editing  button on the Scenario 360 toolbar or click Start Edit on the 360 

Analysis tab. 

4. Select Rural as the scenario you wish to edit and click Edit.  Note that your cursor display changes to a 

pointer  and the ArcMap Editor toolbar is displayed (shown below as floating – for more information 

on floating and docked toolbars, see “Working with toolbars in ArcMap” on page 27). 

 

5. Drag a small box around a building colored red (it is displayed in red because it is in too close to the 

nesting area).  ArcMap will highlight the selected feature and place crosshairs on it . 

6. Place your mouse cursor over the crosshairs on the building, click on it, and drag the building North and 
East to a new location further away from the nesting area. When you stop dragging, you will see the 

building turn green  to indicate it is now in a suitable location.  The charts will also change very 
slightly. 

7. Click Stop Scenario Editing  on the Scenario 360 toolbar or Stop Edit on the 360 Analysis tab 

and answer No when asked if you want to save your edits. 
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Changing water tank location assumptions to determine water pressure suitability 

In this analysis there are three possible locations (Site A, Site B, or Site C) for a water tank.  The proposed 

development sits in a high mountain valley, so water pressure can be a problem.  In this fictional analysis, it has 
been determined that a suitable building site must be at least 60 feet below a water tank.  To see how this 

works, you will experiment each of the three possible water tank locations in the Village scenario and see how the 

building site suitability changes.  You may want to zoom out on the map so that you can see all three potential 
sites for water tanks. 

1. Click the Active Scenario drop-down menu on the 360 Analysis tab and select Village as the active 
scenario. 

2. Click the Options menu on both charts and select Clear Previous Values to clear all previous values 

from each charts. 

3. Click the Assumptions  button on the 360 Analysis tab to display the graphical assumptions view. 

4. Click the drop-down list for the Water Tank Site assumption, select Site A, and click the Apply 

Assumption Changes  button. Scenario 360 will update the scenario and dynamically change the 

suitability (from green to red) of all dwelling units located higher than an imaginary threshold of 60 feet 
below the tank at Site A.  Try the same experiment with Site B. 

 

Site A 

  
  

Site B 

  

 

5. If desired, you can experiment with moving water tank locations using the techniques you used to move 

buildings in the exercise “Moving features in the map view to change suitability” on page 33. 
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6. When you are finished, close the Assumptions window and click No when asked whether you want to 

save assumption changes. 

This concludes the suitability portion of the tutorial.  You have seen how changing assumptions and moving 
features on the map can drive changes in indicators illustrated in charts.  The suitability of each building is a 

dynamic attribute that you have seen change based on the analysis you experimented with. 

Running a road cost analysis 
In this exercise you will experiment with changing road construction costs in the Rural scenario.  You will change 

the type of road proposed and then (optionally) change the costs per linear foot in the “Attribute Road Cost” 

lookup table. 
 

Evaluating road costs by experimenting with changing the road type 

1. Click the Active Scenario drop-down menu on the 360 Analysis tab and select Rural as the active 

scenario.  You may find you want to zoom out a little to see all of the houses. 

2. In the ArcMap table of contents, turn off all the layers in the display except Proposed Buildings, 
Proposed Roads, and communityville.tif.   

3. Right-click on Proposed Roads in the ArcMap table of contents and click Zoom to Layer on the pop-up 
menu. 

4. Expand the Proposed Roads layer in the ArcMap table of contents. Note that there are three types of 
streets in the Proposed Roads layer: arterial, collector, and local. Each type has its own construction 

cost. 

 

 

 

Toggle features on and off in the 
map view by placing or removing 
a check mark in the box next to 

the layer name.  Turn off all 
layers except Proposed 

Buildings, Proposed Roads, 
and communityville.tif. 

Click the  next to any layer or scenario 
in the table of contents to expand the table 

of contents.  Make sure the Proposed 
Roads layer is expanded. 
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5. If the chart view is not open, click the View Charts  button to display Road Cost and Suitability 

charts.  Click the Options menu on both charts and select Clear Previous Values to clear all previous 

values from the charts. 
6. Click the ArcMap List by Selection menu (located at the top of the ArcMap interface). This will open a 

list of available layers that lets you choose which layers you want to select when editing. In this example, 
you want to select a road by but you do not want to select the buildings or any of the features next to it. 

To avoid selecting multiple features, make sure 

all layers except the Proposed Roads layer 

are Non Selectable . 
7. To view or change feature attributes you must 

first be in Edit Mode.  Click the Start 

Scenario Editing   button on the Scenario 

360 toolbar, select Rural as the scenario you 

wish to edit and click Edit.  Note that your 

cursor display changes to a pointer  and 

the ArcMap Editor toolbar is displayed. 

8. Click on the road illustrated below to select it. 
On selection, the road will turn a different 

color. 
9. Click the View or Change Feature Attributes  button on the Scenario 360 toolbar to display the 

Attributes for the feature you selected, in this case the Collector road type. 

 

10. In the Prompted Attributes pane, double-click on Road Type. This will launch a prompt box with a drop-

down list of options. 

 

The name of the data 
layer that you are 
currently viewing 

Features in the data layer.  
Click the feature’s primary 
display field in the tree to 
edit or view its attributes 

view attribute values 

Double-click attributes 

to modify values 
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11. Click the Road Type drop-down list, select Arterial from the drop-down list, and click OK. You have just 

changed that road from a medium-sized “collector” road to 
a larger “arterial” type, which costs more per unit of 

length. Scenario 360 will update the Attributes window 

and the road feature you selected in the map view. The 
program will also dynamically update the Road Cost 

chart to reflect the new, higher cost, and display the 
previous value with gray diagonal lines.  You can see 

exact information by hovering your mouse cursor 
(pausing for a second or two) over the bar in the chart. 

12. Close the attributes window. 

13. Notice that an alert  appears on the chart indicating 

that a pre-established threshold has been crossed – in 

this case, a roads budget.  Hover your mouse cursor 
over the chart bar for more information on chart values. 

You can set alerts to notify you if a goal, target, threshold, or constraint condition has been reached.  An 

alert may be associated with an assumption, a dynamic attribute, or an indicator.  An alert is used to monitor 

values during analysis and reports if specific conditions occur. Alerts may be displayed as a chart with 
(colored) target bars, an alert message, or as a feature color on a map.  An alert has been set in this analysis 

to indicate that the roads budget threshold has been crossed. 

 

14. Click once on Alerts  on the 360 Analysis tab to 
view more information about the alert you have just triggered.  

Clear the alert by clicking the Clear All Alerts button then click 
Close. 

 

15. Click the Stop Scenario Editing  button on the 

Scenario 360 toolbar and click No when prompted to save your 

changes.  
 

 
 

 

 
 

 
 

Comparing scenarios 

This tutorial analysis contains two scenarios. Each scenario represents a different decision-making alternative.  

Scenario 360 includes a powerful scenario comparison display feature that will allow you to view any combination 
of maps, images, and/or charts side by side. 

1. Make sure that Proposed Buildings, Proposed Roads, and communityville.tif are visible (checked 

on in the ArcMap table of contents). 

2. If the chart view is not open, click the View Charts  button to display Road Cost and Suitability 

charts.  Click the Options menu on both charts and select Clear Previous Values to clear all previous 
values from the charts. 

3. Click the Compare Scenarios  button on the Scenario 360 toolbar or click Compare Scenarios on 

the 360 Analysis tab.  

4. Use any of the tools described below to modify the map view.  When you are finished, close the Scenario 
Comparison window. 
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The scenario comparison window includes a toolbar that will allow you to move around the map view, link map 

extents, and select layout options. 

Sometimes just looking at a map isn't enough. You can use the ArcMap Identify  tool to display all the 

attributes of a map feature.  Click the tool then click on a map feature in the scenario comparison view. 

Use the Pan Map  tool to investigate different areas and features of your map view.  Click the tool, move the 

hand over the map display, and click and drag the hand.   

Use the Zoom In , Zoom Out , and Zoom to Full Extent  tools to investigate different areas and 
features of your map view.  Click the tool, move the mouse pointer over the map display and click once to zoom 

around a point in the map view. Alternatively, click and drag a rectangle defining the area you want to zoom in or 
out on.  

Use this Link Map Extents  tool to synchronize the map extents (zoom and pan settings) shown in the 

scenario comparison window with one another and with those in the ArcMap map view. 

 

Click the Select Layout tool  to open an extended toolbar button set of layout options.  You can choose 
from a variety of layout options or customize your window using standard window resize controls (change 

the width or height of any section of the window by clicking and dragging a border to the desired 
location).  Scenario 360 will "remember" your last saved settings and will display the scenario comparison window 

as you saved it each time you open the window. 

Task menu options are available by clicking the Scenario comparison tasks  button or by right-clicking 
on a map, chart, or image in the scenario compare view. 

 

Scenario comparison features 

• The Edit in ArcMap tool is available from the Scenario comparison tasks   menu or by right-

clicking on a map.  This tool allows you to activate a scenario and begin editing it in ArcMap.  This will 

close the Scenario Comparison window and start an ArcMap edit session.  

• The Compare Scenarios  button on the Scenario 360 toolbar or Compare Scenarios on the 360 

Analysis tab options work as toggle buttons.  Click either one to turn the Scenario Comparison window 
on or off. 

Congratulations – you have completed Tutorial 2 
This tutorial has taken you through a sample analysis using Scenario 360. We recommend you look back through 
the steps to review the Scenario 360 features you used and reflect on the overall approach to the analysis, 

focusing more on the functions than on the exact buttons and steps.  Tutorial 3 will walk you through the process 
of setting up a new analysis which you will then be able to explore. 
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Tutorial 3 – Setting up and running an analysis 

This tutorial is based on a fictional urban environment called Community City.  In this tutorial, you will set up an 
analysis to look at the cost implications of adding various structures to a proposed development area.  This 

development envisions a new mixed-use development that includes retail, residential, and office buildings.  The 
analysis will include studying the jobs to population balance for various combinations of retail, residential, and 

office buildings.  You will also explore the construction costs inherent in adding more space.  

 
This tutorial will take you through the basic steps for setting up a new analysis in Scenario 360. You will learn to:  

• create a new analysis  

• define a projected coordinate system 

• create a new base scenario  

• add data layers  

• create, modify, and chart assumptions  

• setup and work with dynamic attributes and formulas  

• create and chart indicators  

• define and display alerts  

• add features 

 
Objective  

Evaluate commercial development options for a mixed-use development. 
 

Issues  

• Population densities  

• New jobs  

• Construction costs  

Starting a new analysis 

1. If you haven’t already, start Scenario 360 by double-clicking on the Scenario 360  icon on your 

desktop.  If Scenario 360 is open, click the Start a Scenario 360 Analysis button on the Scenario 360 
toolbar. 

2. On the Welcome to Scenario 360 window, click Create New Analysis . 

3. Select Create new empty analysis and click Next. 

4. In the Analysis Name field, type Community City. 

5. In the Description field, type My practice analysis for a tutorial and click Next. 

6. Accept Base Scenario as the base scenario name. 

7. In the Description field for the Base Scenario, type Original proposal, click Next, then click Finish.  
Scenario 360 will update your files and create your new analysis folders.  

Prepare your data 
Although prepared data is provided for these tutorials, you will need to get your own data into a projected 

coordinate system such as UTM or State Plane when you are ready to do your own analysis. If you are unfamiliar 
with coordinate systems, refer to ArcGIS help.  

 

Adding data 
In ArcGIS, geographic information is displayed on a map as layers.  Each layer represents a particular type of 

feature such as streams, lakes, or highways.  A layer doesn't store the actual geographic data; instead, it 

references the data contained in coverages, shapefiles, geodatabases, CAD files, images, grids, and so on.  
Referencing data in this way allows the layers on a map to automatically reflect the most up-to-date information 

in your GIS database. 
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Scenario 360 allows you to select additional datasets (e.g. photos, lookup tables, census data, models, and other 
non-geographic data) from which to create layers, and allows you to examine properties of the attributes 

contained in each dataset. 
 

Adding existing data layers  

There are several sources from which to retrieve data for your analysis.  For this tutorial, you will use some 
CommunityViz provided data layers, and also create some of your own data.   

1. Click the 360 Setup tab Work Flow view.  

2. Click once on Data  to open the data list.  

3. Click the Add Data   button. 

4. Select Existing Data Layer and click Continue.  

5. Browse to CVFiles/Tutorial 3 (You may need to add CVFiles to your Folder Connections in ArcGIS 10.  

To do this, click the Connect to Folder  button and browse to your CVFiles folder and click OK.  
Now that you have connected the folder, you can browse to Tutorial 3.) 

6. While holding down the Shift key, click to select both available data layers, then click Add. Scenario 360 
will add the data to your analysis.  If you are asked whether to “Create pyramids,” say yes.  You will see 

an aerial photo and parcels in your map view. These are representative of data you might get from other 
sources in a real analysis.  

Adding a new empty data layer  

Next you will create your own data layer by adding a new, empty dynamic layer for proposed new buildings.  
Later in this tutorial, you will sketch new buildings into this layer. 

1. Click the Add Data   button on the data list (if you closed the data list, you can reopen it from the 360 

Setup tab Work Flow view, Data icon). 

2. Select New Data Layer and click Continue.  

3. In the Name field, type Proposed Buildings. 

4. In the Description field, type Proposal for new buildings.  

5. Click the Layer Type drop-down list and select Polygon.  

6. Leave Link all scenarios unchecked. 

7. Click OK. Scenario 360 will add your new layer to the ArcMap table of contents. Note that the check box 
in the ArcMap table of contents has a bright outline, indicating that this is a dynamic layer.  It is also 

represented with a different icon in the data list.  Close the data list.  You have completed the steps of 

adding data layers to your analysis.  

Working with 360 Setup tab 
The 360 Setup tab is used to access all of the tools and information you need when 

setting up an analysis.  
 

When thinking about an analysis, you can think of it as something with inputs, 
calculations, and outputs - as displayed in the Work Flow view (shown in the image 

right). You can follow the steps suggested by the flow chart to set up your analysis.  

Input 

• Data are inputs that consist of map layers and tables. 

• Assumptions are inputs that are user-defined inputs used in an analysis.  
They are often changeable. 
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Calculations 

• An analysis can contain one or more alternative scenarios. Scenarios are alternative viewpoints of an 
analysis.  Each scenario has distinct input settings and outputs, but identical calculation rules. 

• Attributes are properties or characteristics of map features.  A dynamic attribute is an attribute that 

is automatically or manually updated as changes are made in the analysis using the unique capabilities of 
Scenario 360. 

• Indicators are impact or performance measures.  They are calculated output values that can reference 

data sets anywhere in the scenario.  They are used to provide an overall measurement for a scenario (as 
opposed to an attribute, which provides the individual characteristic of a map feature). 

Output 

• Alerts are thresholds, defined by you, that are associated with particular assumptions, dynamic 

attributes, or indicators.  Alerts let you know if a scenario value is outside of a specification. 

• Charts are a graphical way of looking at indicators or assumptions. 

• Reports summarize the inputs, calculations, and outputs of one or more scenarios. 
 

You can use the Work Flow, Tree, or Category view when setting up your analysis. 

Creating a new category 

Categories are a convenient way to organize a complex analysis by creating groups of information that can be 

applied across all indicators, assumptions, attributes, and charts.  Use categories to filter, sort, and keep track of 
groups of information. 

 
You can create and name your own categories.  In this tutorial, you will create and utilize a Construction Cost 

category that includes all of the indicators, assumptions, attributes, and charts that apply to your work on 

construction costs in the analysis.  

1. Click Category on the 360 Setup tab. 

2. Click the New Category  toolbar button. 

3. Type Construction Cost as the new category name and click OK.   

Reordering categories  

Category order is reflected in category lists throughout the analysis as 
well as in reports. In this analysis, you will use the General category for 

most of your analysis components.  You can put that category at the top 
of the list for easy access when creating components.  

1. Click once to select the General category.  

2. Click the Move Category Up  button.  

Creating assumptions  
Assumptions in a scenario can be defined as fixed or variable.  A variable assumption is an input to the analysis 
that might change as part of the analysis, such as the current interest rate, seasonal resource consumption 

values, or residential density.  A variable assumption may be altered (using a slider bar or other method) during 

analysis and can vary across scenarios. For more information on assumptions, see “Working with assumptions” on 
page 29. 

 
In this exercise, you will set up assumptions about how much of the floor space in the proposed new buildings 

will be used for each purpose.  These will be variable assumptions that you will be able to change later.  You will 
create three variable assumptions: Residential Ratio, Retail Ratio, and Office Ratio.  

Creating the Residential Ratio variable assumption  

The first variable assumption is called “Residential Ratio.”  It represents the percentage of floor space that will be 
dedicated to residential use. 

1. Click once on Assumptions on the 360 Setup tab Work Flow view.  

2. Click the New Assumption  toolbar button. 
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3. In the Name field, type Residential Ratio. (Note that ( ) [ ] { } : , “ ‘, tab, return, leading or trailing 
spaces are not allowed in assumption names.)  

4. In the Description field, type 
Percentage of floor space dedicated 

to residential use.  

5. Accept General as the Category.  

6. Accept Number as the Format.  

7. Accept the selection Yes, this is a variable 
assumption.  

8. Click the Valid Values tab.  

9. Type 70 in the Default Value field, indicating that unless the assumption is changed, 70% of the new 

floor space will be residential. This will be the default display value.  

10. Type % in the Units field.  

11. Accept the default of 1 for the Increment on Slider. This number represents the number of units 

traveled each time you click on the slider increase or decrease buttons when experimenting with the 
assumption values. 

12. Accept 0 as the Minimum value.  

13. In the Decimal Places field, type 0.  

14. Accept 100 as the Maximum.  Leave Use Custom Labels unchecked and click OK.  

Creating the Retail Ratio variable assumption  

1. If you closed the assumptions list, click once on Assumptions on the 360 Setup tab Work Flow view.  

2. Click once on the Residential Ratio assumption in the assumption list to select it then click the 

Duplicate  button. This will create a new assumption with the same properties and values as the 

Residential Ratio assumption.  Any of the new assumption values or properties can be modified as you 

wish.  

3. In the Name field, type Retail Ratio.  

4. In the Description field, type Percentage of floor space dedicated to retail use.  

5. Click the Valid Values tab.  

6. Type 10 in the Default Value field, indicating that unless the assumption is changed, 10% of the new 

floor space will be retail. This will be the default display value.  

7. Accept all other fields and click OK.  

Creating the Office Ratio variable assumption  

1. If you closed the assumptions list, click once on Assumptions on the 360 Setup tab Work Flow view.  

2. Click once on the Retail Ratio assumption and click the Duplicate  button. 

3. In the Name field, type Office Ratio.  

4. In the Description field, type Percentage of floor space dedicated to office use.  

5. Click the Valid Values tab.  

6. Type 20 in the Default Value field, indicating that unless the assumption is changed, 20% of the new 

floor space will be office space. This will be the default display value.  

7. Accept all other fields and click OK.  

8. Close the assumptions list.  

Editing assumptions (optional)  

You have finished setting up the variable assumptions for the analysis.  If you want to make changes however, 

you can. 

1. Open the assumptions list.  

2. Double click on any assumption.  
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3. Change properties, valid values, and alerts.  In this exercise, accept the properties defined in the previous 
exercises and close the assumptions list.  

 

Creating dynamic attributes and associated formulas  
A dynamic attribute is an attribute that is updated as changes are made in the analysis using the unique 

capabilities of Scenario 360.  A formula is associated with each dynamic attribute.  The formula specifies how the 
attribute is calculated.  

Dynamic attribute formulas  

Formulas are expressions that specify how the elements of an analysis depend upon one another. They are 
statements in an equation of facts, rules, principles, or other logical relationships.  The ability of Scenario 360 to 

calculate values dynamically, using formulas, is a powerful and unique tool; it enables you to make changes in 
your analysis and see the results immediately. 

 

Types of formulas  

• Attribute formulas specify the value of dynamic attributes, which are changeable characteristics 
associated with particular features on the map.  Example attributes include name of a road, number of 

children living in a house, or taxes for a particular lot.  Attribute values are usually found by looking at 
symbols on a map or by clicking on a particular feature to open its attribute table.  

• Indicator formulas specify the value of indicators, which quantify information that pertains to a 

scenario as a whole. Example indicators include cost of roads, number of school-age children in a 
neighborhood, or town tax revenues.  

 

For example, an attribute formula might be used to calculate the cost of each proposed road feature on a map by 
multiplying the length of the road times the cost per square foot.  An indicator formula might be used to sum the 

total costs for all roads in a scenario by adding the above attribute values.  
 

In the following exercises, you will be creating new dynamic attributes and attribute formulas using a variety of 

options for creating formulas.  You will create indicators and indicator formulas later in this tutorial.  

Using the Formula Wizard to create a prompted dynamic attribute  

Recall that you created a new, empty layer called Proposed Buildings. During analysis, a user will sketch new 
buildings on the map.  You want the software to “ask” the user how many stories tall the building is by displaying 

a small dialog box each time a new building is created. This is known as a “prompted” attribute.   

1. Click once on Dynamic Attributes on the 360 Setup tab Work Flow view.  

2. Click the New Attribute  button. 

3. In the Name field, type Stories.  

4. In the Description field, type Prompts the user to enter the number of stories for new 

buildings.  

5. Accept General as the Category.  

6. Click the Layer drop-down list and select Proposed Buildings.  

7. Accept Number as the Attribute Type field.  

8. Leave the Units field blank.  

9. In the Decimal Places field, type 0. Leave the Auto-Statistics box unchecked. 

10. Click the Formula tab.  

11. Click the Formula Wizard button.  The Formula Wizard assists you in constructing the most common 
types of analysis formulas.  

12. Attributes can be designated as numeric, yes/no, or text. Each of these attribute types include different 

options when constructing formulas in the Formula Wizard.  You are going to be creating a formula 
function that prompts a user when creating buildings to enter a number (the number of stories in 

building).  Select the Prompt for a number option and click Next.  
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13. Select the Prompt for a specific numeric value option and click Next.  

14. In the Question or statement for prompt field, type 

Please specify number of stories.  

15. Click to place a check mark in the Provide Default Value box 

and type 1 in the field provided.  

16. Notice that the program displays your entries in the Preview 
of prompt window as well as a preview of the formula in 

progress.  Click Next.  

17. Click Finish but do not close the attribute creation window. 

 

Creating an alert  
You can create an alert to notify users when they create a building that is over 10 stories tall. 

1. Click the Alerts tab in the attribute creation window.  

2. Click New.  

3. In the Alert Name field, type Too Tall.  

4. In the Description field, type Building is more than 10 stories tall.  

5. In the If Stories is operator drop-down list, select > (greater than) in the first box and type 10 in the 

next box.  

6. In the Display the following messaging in a popup window field, type This building is more 

than 10 stories tall.  

7. Accept the default Alert Color and click OK.  Click OK to close the attribute creation window. 
 

Testing your new formula and alert  

You can sketch a new building in your map view and watch your new formula at work.  

1. Using the ArcMap zoom tools, zoom in on the parcels area of the map view.  

2. Make sure the symbology in the table of contents for the Proposed Buildings layer is a noticeable 
color. If it isn’t, you can double click on the symbol, click the Symbology tab, and select a new color.  

3. Start an editing session by clicking the Start Scenario Editing button  on the Scenario 360 toolbar.   

4. Make sure the Proposed Buildings layer is the only selectable layer in the List by Selection menu. 

5. Click on Proposed Buildings in the Create Features window. 
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6. Use the ArcMap 
Construction tools to 

draw a large polygon 
in one of the parcels 

to represent the 

footprint of a 
potential new 

building (see image 
at right). Click to 

create each point, 
when you have 

finished creating your 

points, double-click 
on the last point to 

complete the 
polygon. 

7. When prompted, type 

11 in the Stories field 
and click OK.  

8. Because you 
exceeded the 

threshold you set 
(buildings cannot be 

more than 10 stories tall), the new building is displayed with a red border around it.  

9. Click the Stop Scenario Editing button  on the Scenario 360 toolbar and click Yes to save your 

edits.  

10. Click the List Alerts  button on the Scenario 360 toolbar to view the alert notification, then close the 

list alerts window.  

Using the Formula Editor to create a dynamic attribute  
You can create a dynamic attribute in the proposed buildings layer that will calculate the area of a building in 
square feet.  

1. From the attributes list click the New Attribute  button (if you closed the attributes list, you can 

reopen it by clicking Dynamic Attributes on the 360 Setup tab Work Flow view). 

2. In the Name field, type Building Area.  

3. In the Description field, type Total area of building in square feet, including all floors.  

4. Accept General as the Category.  

5. Click the Layer drop-down list and select Proposed Buildings.  

6. Accept Number as the Attribute Type field.  

7. Leave the Units field blank (this will be calculated for you).  

8. In the Decimal Places field, type 0.  

9. Click the Formula tab.  

10. Click the Edit Formula button. The Formula Editor will be used to create this formula.  Conceptually, 

the formula is simple: multiply the area of the building’s footprint by the number of stories.  
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11. Double-click Area in the function list. You will see the text appear in the formula box.  For detailed 
information on the Area function, click the More help on this function link.  

12. Using the Formula Editor keypad, click the multiplication sign *. 

13. Click the Insert Analysis Component button  on the Formula Editor toolbar. 

14. Double-click on Attribute on the pop-up menu, then double-click on Stories on the pop-up menu  

(you may have to scroll down).  

 

15. Your new formula should read: 
Area ( [Attribute:Shape] ) * [Attribute:Stories] 

16. Click Check Formula, then click OK.  Click OK again to close the New Attribute window. 

Using the Formula Wizard to create a dynamic attribute  
Now that you have set up the building area and the percentage of area dedicated to residential, retail, and office 

use, three simple formulas will give you the absolute area dedicated to each use. 

Calculating office area 

1. If you closed the attributes list, you can reopen it by clicking Dynamic Attributes on the 360 Setup 

tab Work Flow view.  

2. From the attributes list click the New Attribute   button. 

3. Create a new attribute named Office Area in the Proposed Buildings layer. Use the Number type, 

General category, and set the decimal places to 0.  
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4. In the Description field, type Building area dedicated to office use.  

5. Click the Formula tab and click Formula Wizard.  

6. Click to select the Calculate a value option and click Next.  

7. Using the drop-down lists provided, select the options shown in the image below.  You will have to click 

the Add Line button to create a third line.  

 

8. Your formula should read: 
[ Attribute:Building Area ] * [ Assumption:Office Ratio ] / 100  

9. Click Next then click Finish.  

10. Click OK to close the attribute creation window.  

 
This completes the creation of the Office Area formula.  You can make a similar formula for retail very quickly 

using the Copy formula button in the Formula Editor, as described in the next section. 

Duplicating a dynamic attribute to calculate retail area  

1. If you closed the attributes list, click once on Dynamic Attributes on the 360 Setup tab Work Flow 

view.  

2. Click once on the Office Area attribute and click the Duplicate  button. 

3. Rename the attribute Retail Area. It is in the Proposed Buildings layer. Use the Number type, 
General category, and set the decimal places to 0.  

4. In the Description field, type Building area dedicated to retail use.  

5. Click the Formula tab and click Edit Formula.  

6. Replace the word Office with the word Retail in the formula. The formula should read: 
[ Attribute:Building Area ] * [ Assumption:Retail Ratio ] / 100 

7. Click Check Formula, then click OK. Click OK again to close the attribute creation window.  

Copying a formula to calculate residential area  

1. From the attributes list click the New Attribute  button. 

2. Create a new attribute named Residential Area in the Proposed Buildings layer. Use the Number 
type, General category, and set the decimal places to 0.  
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3. In the Description field, type Building area dedicated to residential use.  

4. Click the Formula tab and click Edit Formula.  

5. Click the Copy formula from another attribute   button, click once to select the very similar 

attribute Office Area, and click OK.  

6. Replace the word Office with the word Residential in the formula.  The formula should read: 
[ Attribute:Building Area ] * [ Assumption:Residential Ratio ] / 100  

7. Click Check Formula, then click OK. Click OK again to close the attribute creation window.  

8. Close the attributes list.  

Creating a new chart  
Values for indicators and assumptions are automatically calculated as you experiment with alternatives, and the 

results can be displayed graphically in a chart.  Charts are dynamically linked to assumptions and indicators.  As 

changes are made in the analysis, chart displays will update automatically to reflect analysis results.  
 

In this exercise, you will create a pie chart that tracks the percentage of each building type.   

1. Click once on Charts on the 360 Setup tab Work Flow view.  

2. Click the New Chart toolbar   button. 

3. In the Name field, type Floor Space Ratios.  

4. This will become the title of your chart. Leave the Subtitle field blank.  

5. Click the Type drop-down list and select Pie.  

6. In the Decimal places field, type 0.  

7. If they are not there already, place checks by Display Values, Display Legend, and 3D.  

8. Click the Data tab and click the Add Assumption button.  

9. Click once on Residential Ratio to select it, then click OK.  

10. Click the Add Assumption button, click once on Retail Ratio to select it, then click OK.  

11. Click the Add Assumption button, click once on Office Ratio to select it, then click OK.  

12. Click OK to close the create chart window. Your new chart will be added to the list.  

13. Close the charts list.  You chart will look something like this.  If there are “leader lines” pointing to the 

chart labels, try making the chart wider to remove the leader lines. 

 

 

14. Save your analysis by clicking the Save button on the ArcMap toolbar.  
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Tutorial 3b – Advanced setup and analysis  
This part of the tutorial includes the advanced topic of lookup tables, which can sometimes be used in complex 
analyses.  Once you have created your lookup table, you can create dynamic attributes that reference information 

in it.  You must first complete Tutorial 3a before beginning this tutorial.  

Creating a lookup table  
You will start by creating a lookup table.  Strictly speaking, you don’t need a lookup table for this formula.  

Lookup tables are best for large amounts of data that don’t change very often (like tax rates).  We are using a 

small lookup table here to expose you to this potentially useful technique.  There are several ways to create 
lookup tables from scratch; we are presenting one option here.  

1. Make sure that you are not in an active editing session (click the Stop Scenario Editing  button on 

the Scenario 360 toolbar if available). 

2. Click once on Data on the 360 Setup tab Work Flow view.  

3. Click the Add Data button  

4. Select New Data Layer and click Continue.  

5. In the Name field, type Lookup, then type a description of your choice in the Description field.  

6. Click the Layer Type drop-down and select Table.  

7. Click OK then close the data list.  

8. Click the 360 Setup tab then click the Tree view.  

9. Click the + next to the Data folder to expand the folder.  

10. Right-click on Lookup and click Open Attribute Table from the pop-up menu to display the attributes 

of this table.  

11. Click the Table Options button (at the top left of the table) and click Add Field on the drop-down 

menu.  

12. In the Name field, type Land_Use (spaces are not allowed).  

13. Click the Type drop-down and select Text. This will be the column in your table that specifies residential, 

office, or retail.  

14. Click OK. A new field should appear in the table.  To see it, you may need to resize the table.  Note that 

you can resize columns by dragging on the divider between headers. 

15. Using the Long Integer type, create additional fields for Area_per_Dwelling_Unit, 

Area_per_Employee, and Cost_per_Sq_Foot (use the directions in #11-#14).  

16. Start an editing session by clicking the Start Scenario Editing  button on the Scenario 360 toolbar.  

17. Enter three rows of data in your table, as displayed in the image below.  Note that you do not need to 

enter any data in the OBJECTID* field or the SCENARIO field or the CVActive field (if present). Those will 
populate automatically.  You may need to resize the window to see the table properly.  

 

18. Click the Stop Scenario Editing  button on the Scenario 360 toolbar. When asked if you want to 

save your edits, click Yes. Close the lookup table.  

 

Editing attributes  
1. Right-click on the Attributes folder (360 Setup tab Tree view) and click Attribute List on the pop-up 

menu.  

2. Click once on the Area_per_Employee attribute and click the Properties   toolbar button. 

3. Ensure that the Attribute Type drop-down list reads Number.  

4. Change the Decimal Places field to 0.  

5. Click OK and close the attributes list.  
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Creating a variable assumption  
In this exercise, you will setup an assumption for persons per dwelling unit and use this assumption to study jobs 

to population balance for various combinations of retail, residential, and office buildings.  

1. Click once on Assumptions on the 360 Setup tab Work Flow view then click the New Assumption 

  toolbar button. 

2. In the Name field, type Persons per Dwelling Unit.  

3. In the Description field, type Average number of people living in each dwelling unit.  

4. Click the Valid Values tab.  

5. Type 1.6 in the Default Value field, indicating that unless the assumption is changed, the average 

number of people in each dwelling unit is 1.6. This will be the default display value.  

6. Leave the Units field blank and accept 0 as the Minimum value.  

7. Type .1 for the Increment on Slider.  

8. In the Decimal Places field, type 1.  

9. Type 4 as the Maximum and click OK.  

10. Close the assumptions list.  

Creating dynamic attributes using information from a lookup table 
You are now ready to create new dynamic attributes.  You will use the Formula Wizard and Formula Editor to 

create your formulas. Many of the new attributes will rely on your lookup table for data.  

Creating the Office and Retail Employees dynamic attributes  
The formula for these attributes will rely on your lookup table for data and will calculate the number of 
employees expected in the new buildings based on the square feet of office space.  The formula starts by 

calculating the square feet of office or retail space and then divides by the number of square feet associated with 

each employee. It gets the number from the lookup table which shows how many square feet are needed for 
employees of offices or retail stores.  

1. Open the attributes list and create a new attribute named Office Employees in the Proposed 
Buildings layer. Use the Number type, General category, and set the decimal places to 0.  

2. In the Description field, type Number of employees expected based on availability of office 

space.  

3. Click the Formula tab then click the Edit Formula button.  

4. Click the Insert Analysis Component  button on the Formula Editor toolbar.  

5. Double-click on Attribute on the pop-up menu, then double-click on Office Area on the pop-up menu.  

6. Using the Formula Editor keypad, click the division sign /.  

7. Double-click Get in the function list. You will see the text appear in the formula box.  

8. Click on attribute in the formula preview box and the Select Attribute window will appears.    

9. Scroll down the list, click once on Area_per_Employee, then click OK.  

10. Click on where in the formula preview box and the Add Where Conditions to Formula window will 

appears.  

11. Click the Attribute drop-down and select Land_Use, accept the = (equal) operand.  

12. Click the Value drop-down list, select Office, then click OK. Your formula should read:  
[ Attribute:Office Area ] / Get ( [ Attribute:Lookup:Area_per_Employee ], 

Where ( [ Attribute:Lookup:Land_Use ]= "Office" ))  

13. Click the Check Formula button. Click OK after you have finished.  

14. Click OK to close the New Attribute window.  

15. The Improve Analysis Performance window will ask “Create attribute indexes?” Accept the default 

“Create an index for each checked attribute.” 

16. Create a new Retail Employees attribute by duplicating the Office Employees attribute (use the 

Duplicate button on the attribute setup list).  Make sure your decimal points are correct and that you 

replace “Office” with “Retail” in the name and description fields as well as in the formula.  The formula 
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should read:  
[ Attribute:Retail Area ] / Get ( [ Attribute:Lookup:Area_per_Employee ], 

Where ( [ Attribute:Lookup:Land_Use ] = "Retail" ) )  

17. Click the Check Formula button. Click OK after you have finished.  

18. Click OK to close the New Attribute window.  

 

Creating the Dwelling Units dynamic attribute  

You will use this attribute to calculate population.  As you change the persons per dwelling unit assumption, this 

attribute will update automatically.  

1. Create a new attribute named Dwelling Units in the Proposed Buildings layer.  Use the Number 
type, General category, and set the decimal places to 0.  

2. In the Description field, type Area per residential dwelling unit.  

3. Click the Formula tab then click the Edit Formula button.  

4. Using the skills you have practiced earlier, see if you can create this formula:  
[ Attribute:Residential Area ] / Get ( [ 

Attribute:Lookup:Area_per_Dwelling_Unit ], 

Where ( [ Attribute:Lookup:Land_Use ]= "Residential" ))  

You can use the hints in the picture below to create your formula.  Remember, you must click Check Formula 
before clicking OK. 

 

Creating the Population dynamic attribute  

You need to calculate population in order to experiment with jobs to population balance for different 

combinations of retail, residential, and office buildings.  You will begin creating this formula using the Formula 
Wizard and then complete it using the Formula Editor  

1. Create a new attribute 

named Population in 
the Proposed 

Buildings layer. Use 
the Number type, 

General category, and 
set the decimal places 

to 0.  

2. In the Description 
field, type Population 

based on persons 
per dwelling unit, 

number of dwelling 

units, and office and 
retail employees.  

3. Click the Formula tab 
then click the Formula 

Wizard button.  

4. Click Calculate a 
Value then click Next.  

5. Using the drop-down 
lists, create the formula 

shown in the picture on 
the next page. 

 

6. Click Next  

7. Click the Open Formula Editor button and click Yes when asked if you want to continue.  
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8. To demonstrate how you can modify a formula after it has been created by the Formula Wizard, type 
parentheses in the correct places so your formula reads:  
( [ Attribute:Dwelling Units ]*[ Assumption:Persons Per Dwelling Unit ] ) 

+ [ Attribute:Office Employees ]+[ Attribute:Retail Employees ]  

9. Click the Check Formula button.  Click OK after you have finished.  

10. Click OK to close the New Attribute window but do not close the attributes list.  

 

Creating the Construction Cost dynamic attribute  

Later, you will run a cost analysis.  You will consider adding another building to the development project.  

However, your budget is limited. How much space can you add?  You will use this attribute to answer this 
question and see the results of the additional space immediately.  

1. Create a new attribute named Construction Cost in the Proposed Buildings layer. Use the Number 
type, Construction Cost category, and set the decimal places to 0.  

2. In the Description field, type Cost per square foot of office, residential, and retail space.  

3. Click the Formula tab then click the Edit Formula button.  

4. Using the skills you practiced earlier, see if you can create this formula (don’t forget to insert the 

parentheses!): 
( [ Attribute:Office Area ] * Get ( [ Attribute:Lookup:Cost_per_Sq_Ft ], 

Where ( [ Attribute:Lookup:Land_Use ] = "Office" ) ) ) + 
( [ Attribute:Residential Area ] * Get ( [ Attribute:Lookup:Cost_per_Sq_Ft ], 

Where ( [ Attribute:Lookup:Land_Use ] = "Residential" ) ) ) +  

( [ Attribute:Retail Area ] * Get ( [ Attribute:Lookup:Cost_per_Sq_Ft ],  

Where ( [ Attribute:Lookup:Land_Use ] = "Retail" ) ) ) 

5. Remember, you must click Check Formula before clicking OK. 

6. Click OK on the New Attribute window. 

7. Close the attributes list.  

Creating indicators and alerts  
Indicators are impact or performance measures that can reference datasets anywhere in a scenario.  They are 

used to provide an overall measurement and they apply to an entire scenario (as opposed to an attribute, which 
provides the individual characteristic of a map feature).  Like dynamic attributes, indicator values are 

automatically recalculated as you experiment with alternatives, and these values can be displayed in a chart.  In 

this fictional analysis, you will use indicators to total population, employees, construction costs, and ratio of 
square footage and you will display your results in easy to read charts.  

Creating the Population indicator  

1. Click once on Indicators on the 360 Setup tab Work Flow view.  

2. Create a new indicator named Population. Use the General category, and set the decimal places to 0.  

3. In the Description field, type Total population.  

4. Click to place a checkmark next to Display this indicator in a new chart.  

5. Click the Formula tab then click the Formula Wizard button.  

6. Select Add the values of an attribute and click Next.  

7. Click to select Proposed Buildings from the Select Layer drop-down list.  

8. Click to select Population from the Select attribute to sum drop-down list.  

9. Ensure the Sum all features in Proposed_Buildings option is selected and click Next.  

10. Click Next on the Preview Formula Results window.  

11. Click Finish on the Finish Formula window. Your formula should read:  
Sum ( [ Attribute:Proposed_Buildings:Population ])  

12. Click OK to close the New Indicator window.  Note that a new chart has been created.  If your charts 

view is not open, click the View Charts  button on the Scenario 360 toolbar.  
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Creating the Employees indicator  

1. Create a new indicator named Employees. Use the General category, and set the decimal places to 0.  

2. In the Description field, type Total number of employees (retail and office).  

3. Click to place a checkmark next to Add this indicator to an existing chart then click the Select 

Charts button.  

4. Click to select Population from the chart list and click OK.  

5. Click the Formula tab then click the Formula Wizard button.  

6. Select Add the values of an attribute and click Next.  

7. Click to select Proposed Buildings from the Select Layer drop-down list.  

8. Click to select Retail Employees from the Select attribute to sum drop-down list.  

9. Ensure the sum all features in Proposed Buildings option is selected and click Next.  

10. Click to select the Include additional calculations or values in this formula option and click Next.  

11. Select Add the values of an attribute and click Next.  

12. Click to select Proposed Buildings from the Select Layer drop-down list.  

13. Click to select Office Employees from the Select attribute to sum drop-down list.  

14. Ensure the sum all features in Proposed Buildings option is selected and click Next.  

15. Click Next on the Preview Formula Results window. 

16. Click Finish. Your formula should read:  

Sum ( [ Attribute:Proposed_Buildings:Retail Employees ])  

+ Sum ( [ Attribute:Proposed_Buildings:Office Employees ])  

17. Click OK to close the New Indicator window.  Note that the employees chart information has been added 

to the population chart.  

Creating the Construction Cost indicator and alert 

1. Click once to select the Population indicator 

in your indicators setup list then click the 

Duplicate   

button.  

2. Create a new indicator named Construction 
Cost. Use the Construction Cost category, 

and set the decimal places to 0.  

3. In the Description field, type Total cost of 

construction.  

4. Edit the formula so that it reads:  

Sum ( [ Attribute:Proposed 

Buildings:Construction Cost ] )  

5. Remember to check your formula before 
clicking OK.  

6. Click the Alerts tab, then click New. Use 

the information provided in the image below 

to create your new alert.  
 

7. Click OK to close the alert creation window.  

8. Click OK to close the New Indicator 
window.  

9. Close the indicators list.  

Hint: seven 0s 
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Creating and editing indicator charts  
Charts are dynamically linked to indicators and attributes.  As changes are made in the analysis, chart displaying 

values for indicators or attributes will update automatically to reflect analysis results.  You created an attribute 

chart earlier in this tutorial (floor space ratios).  You will now create a new indicator chart and edit a previously 
created chart so you can easily view changes and make comparisons in your analysis.  

Creating a chart with a threshold line to track the total cost of construction  

1. Click once on Charts on the 360 Setup tab Work Flow view.  

2. Create a new chart named Construction Cost. Use the Bar type and set the decimal places to 0.  

3. Click the Data tab and click the Add Indicator button.  

4. Click once on Construction Cost to select it, then click OK.  

5. Click the Axes tab, click to remove the checkmark next to Label, click to remove the checkmark next to 

Auto Axis, type 0 as the Minimum, and type 100000000 (hint: eight 0s) as the Maximum.  

6. Make sure the Increment option is checked on and type 100000 (hint: five 0s) as the increment.  

7. Click the Threshold Lines tab. Note that the alert you set when you created your indicator created a 

threshold line in your chart.   

 

Adding an item line to the chart 
1. Click the Item Lines tab  

2. To add a line whose position shows the value of an indicator or assumption, use the Add Indicator or 

Add Assumption button.  To add a line with a set value, use the Add Custom button.  Fill in the 
position which refers to the value of the line on the vertical Y-axis and choose the color. The line will be 

added. Notice that it is a dashed line.  
3. Click OK to close the create chart window. Your new chart will be added to the list. 

 

Editing the Population chart  

1. Click once to select the Population chart on the charts list then click the Properties  button. 

2. In the Name field, type Population and Employees then set the Decimal places to 0.  

3. Click the Axes tab, ensure there is no checkmark next to Label, and type 0 as the Minimum and 5000 

as the Maximum.  

4. Click to select the Increment option and type 100 as the increment.  

5. Click OK to close the chart creation window. Your new chart will be added to the list.    

6. Close the charts list and save your analysis.  

Experimenting with assumptions  
During assumption setup, you divided the building 

type ratio at 70% residential, 20% office, and 10% 
retail for the base scenario. Changing these 

assumptions will dynamically change the population 
balance and the construction costs. Note that the way 

this formula is set up, there is nothing stopping you 
from making the ratios add up to more than 100%. 

The pie chart you created will continue to display the 

relative ratios.  

1. Make sure the charts view is open.  If it is 

not, click the View Charts  button on the Scenario 360 toolbar.  

2. Click once on Assumptions on the 360 Analysis tab to display the graphical view of the assumptions.  

3. Increase the Office Ratio assumption value to 60%.  

4. Decrease the Residential Ratio value to 30%. 
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5. Click the Apply Assumption Changes  button. Scenario 360 will update the scenario and 

dynamically change the indicators, the results of which are displayed on the charts.  Increasing the office 

ratio while decreasing the residential ratio will increase the population and construction costs.  If your 
construction budget exceeded 60,000,000, the alert you set will be triggered and the chart bar will turn 

red.   

6. Notice the gray diagonal lines on the bar graph indicating the previous values.  Hover your mouse over 

one of the bars on the chart to display a pop-up information window. 

7. When you are finished, close the Assumptions window and click No when asked whether you want to 
save assumption changes.  

8. To revert to the original default settings on the charts, click the Options button on each chart and select 
Clear Previous Values.  

Adding new buildings and modifying building stories  

In this exercise, you are considering adding another building to the development project.  However, your budget 
is limited. How much space can you add?  In Scenario 360, you can find out simply and see the results of the 

additional space immediately.  

Construction Budget 

The bar graph for construction costs should look similar to the one illustrated here (you may have different 
values). Note the red threshold line at the $60,000,000 level.  

 

1. Start an editing session by clicking once on Start Edit 

on the 360 Analysis tab.  

2. Click on Proposed Buildings in the Create Features 
window.  

3. Draw a new polygon to represent a potential new 
building (see image on next page). When you have 

finished creating the four points, double-click on the 

last point to complete the polygon.  

4. When prompted, type 6 in the Stories field and click 

OK. Notice that this building does not have a dark red 
line around it. This is because it does not cross the 

threshold you set for number of stories (it is  
not > 10 stories). 

 

5. The six-story building probably caused the Construction Cost chart to change the bar to red because 
the cost exceeded your budget.  Your budget will not allow for an additional six-story building of that 

size.  The target line was exceeded and an alert was triggered.  
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6. Click the List Alerts button the Scenario 360 toolbar to view your alerts.  

7. Do not stop your editing session at this time.  

Modifying building stories  

1. Click the Edit Tool  on the ArcMap Editor toolbar then click once to select the eleven-story building 

you previously created (the one displaying the alert).  

2. Click the View and Change Feature Attributes  button on the Scenario 360 toolbar. Double-click 
on the Stories property and, when prompted, enter 3 in the Stories field. 

 

3. Click OK. The program will update the indicators and associated charts.  

4. Close the Attributes table, click Stop Edit  on the 360 Analysis tab, and click Yes when asked 

whether you want to save changes.  

5. Click the List Alerts  button on the Scenario 360 toolbar then click the Clear All Alerts button.  

 

 

Exploring further  
This is the end of the tutorial exercises for Community City, but you should feel free to experiment and explore 

further. For example:  

• Using the options available on the 360 Analysis tab, try changing the persons per dwelling unit 
assumption, or editing values in the lookup table.  Practice editing the proposed buildings – change their 

shapes, change the number of stories, move, and delete buildings (all of these functions are available on 
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the ArcMap Editor toolbar).  Picture the development you would like to see and try to make it come in 
under budget and maintain a roughly even jobs-to-population ratio.  

• Try creating a report for this analysis.  

• Use the Scenario Comparison window to create a view you think would effectively convey the main points 

of this analysis to a large audience.  
 

Congratulations – you have completed Tutorial 3  
You have successfully completed creating a new analysis and base scenario for My City.  We recommend you look 
back through the steps to review the Scenario 360 features you used and reflect on the overall approach to the 

analysis, focusing more on the functions than on the exact buttons and steps.  The next tutorial will show you 
how to use Scenario 3D. After you have completed the Scenario 3D tutorial, you might want to try repeating the 

exercise using your data from Community City.  
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 Tutorial 4 – Working with Scenario 3D 

The following tutorial contains a series of exercises that demonstrate how to use Scenario 3D to create 
interactive, geospatial, three-dimensional scenes. Using the Scenario 3D Exporter, you will create a scene 

containing terrain and various features.  Then, using the Scenario 3D Viewer, you will navigate and interact with 
the scene you have created.  You will experiment with interactions between the 2D map and the 3D scene, make 

bookmarks and a flythrough, and set up hyperlinks.   

 
Scenario 3D scenes are built from ArcMap maps.  If the map is part of a Scenario 360 analysis you can take 

advantage of certain additional features, but Scenario 360 is not required.  For this exercise you will start with the 
Sunny Vista Scenario 360 analysis that is also used in some other tutorials. 

 

Starting the tutorial 

1. Install the tutorials data on your computer. 

2. Start Scenario 360 by double-clicking on the 
Scenario 360 icon on your desktop. 

3. Click Open Existing Analysis, browse to the 

CVFiles/Sunny Vista analysis, select it, and click 
OK.   

4. Scenario 360 will load and display a fictional place 
called “Sunny Vista”.  Sunny Vista is a high 

mountain site on the outskirts of a mountain town 

being considered for development. 
 

3D Exporter toolbar 
Scenes are created by specifying how you want features 
from the map to be displayed in the 3D scene, and then 

exporting.  All the tools you need are provided via the 
Scenario 3D Exporter toolbar. 

 

 
  

If the 3D Exporter toolbar is not already showing: 

1. Make sure that the Scenario 3D extension is turned on in ArcMap.  From the ArcMap Tools menu, choose 
Extensions… and place a check in the box next to Scenario 3D. 

2. Make the toolbar visible.  From the ArcMap Customize menu, choose Toolbars… and place a check 
next to Scenario 3D. 

3. If the toolbar buttons are grayed out and unusable, make sure Scenario 3D is licensed on your computer. 
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3D Scene Settings – General 

Most of the “work” of creating a scene is done via 3D Scene Settings , available from the Scenario 3D 

toolbar. 

1. Click 3D Scene Settings  on the Scenario 

3D toolbar.  On the General tab, review the 

default settings.  Make sure there is a valid 
Export Path. The Export Path tells you the 

scene’s name and where it will be stored.  
You can change this information if desired by 

clicking on the Browse  button.  You can 

also edit the Author and Description if 

desired.  Accept the default Background of 
Mountains for this exercise. Do not click OK 

yet; you are going to keep working on the 

other tabs in this window. 

 

 

 

 

3D Scene Settings – Scenarios & Layers 

The 3D Scene Settings Scenarios & Layers tab is like a table of contents for your 3D scene settings.  You use it 
to select which layer you want to work on, and you can also use it to see which layers have already been set up.  

  

1. If there are multiple scenarios or data 

frames in your project, you can select 

which one(s) you want to export by 
clicking the check box the Scenarios list.  

In this case, check the box for Proposal 
A.  You can export multiple scenarios to 

view them in Scenario 3D. 

2. The Terrain Layer is used to create the 
ground surface or landscape in the scene.  

It is optional, but without it the scene will 
have flat ground.  You can use a raster, 

TIN, or feature layer that exists in your 
map.  For this exercise, choose Contour 
Lines and specify the Height attribute 

CONTOUR.  Also check the box labeled 
“Clip layers to terrain extent.” 

 

In the 3D scene, the terrain itself is invisible; it is only used by the computer to calculate vertical positions.  

Normally you want to create a visible ground layer that drapes over the terrain and looks like ground cover.  An 

aerial image is desirable but not required.  For this exercise, we’ll use the Aerial Image layer.  To set it up:   

3. Double-click the name Aerial Image in the Layers list.  (Alternatively you can click it once and then 

click the Edit Layer Settings  button.) 
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4. In the 3D Layer Settings – Aerial Image screen that appears, accept the defaults and click OK.  
Notice that there is now a yellow cube next to Aerial Image in the list, indicating that it has been 

assigned 3D settings.  The yellow cube also contains a green check by default, 
indicating that this layer will be included the next time the scene is created.  (You can clear the check if 

desired, but leave it in place for this exercise.) 

 

“Sneak Peek”  

To give yourself a quick preview of how your scene is developing: 

1. Click OK at the bottom of the 3D Scene Settings screen to return to the toolbar. 

2. On the Scenario 3D toolbar, click Export Now . This will create a scene using your settings so far. 

3. Click Launch Scenario 3D Viewer  to open the scene in the Scenario 3D Viewer. You’ll see the 

Mountain background you chose on the 3D Scene Settings - General tab and the Aerial Image ground 
layer you chose draped over the terrain.  There isn’t much more to see yet, so for now close the 3D 

Viewer window and return to set up.  Details on using the 3D Viewer come later in this tutorial. 

 

3D Scene Settings – Lines 

In the next few sections of the tutorial you will make settings for two line layers, two polygon layers, and two 

point layers.  There are many options available for these settings; the exercises here will give a small sample. 

Features that are lines on a 2D map can be represented several ways in 3D.  They can be shown as images on 

the ground; they can be horizontal “ribbons” that add width to the line; they can be “fences” that add height to 
the line; or they can be “walls” with both width and height.  You can also choose whether you want them to be 

confined to a single horizontal plane (“flat”) or follow the contours of the terrain (“surface conforming”).  Finally, 

you can choose how you want their surfaces colored or textured.  In this example we’ll set up the line layer 
Streams as thin, surface-conforming ribbons and the line layer Roads as surface-conforming ribbons with a little 

bit of thickness. 

1. From the Scenario 3D 

toolbar, click 3D Scene 

Settings .  Go to the 

Scenarios & Layers tab  
and double-click Streams  
in the Layers list.  

2. The 3D Scene Settings 

screen reads from left to 

right.  Under Substitution 
Method, choose Single.  

This means that each 
feature in the layer will be 

represented the same way. 

3. There are tabs for both the 
Top and Sides of the 3D 

object you will create.  In 
this case, ignore Sides and 

ensure you are working on the Top tab.  For Material, select Choose a texture.  Use the Browse  

button to open the Library Browser. 

The Library Browser is a special Scenario 3D tool that allows you to find and organize content for use in 3D 
scenes.  It supports Backgrounds like the Mountain background you are using, Textures that can include photos 
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and other graphics, Materials like the water you are about to use, and Models or 3D objects.  The Views  
button in the upper left lets you choose thumbnails, list, or details. 

4. In the Library Browser, navigate to Library/Materials and click on the name Ocean in the right-
hand window.  Click Open.  This will select the water material and you will be returned to the 3D Layer 

Settings screen. Confirm that the Material texture is now Ocean.template and look for a Preview in the 
small preview window.  

5. Look at the setting options in the Shape panel.  Then set them as follows: 

a. Leave the check in the box called Same for all models.   

b. Streams follow the terrain, so for Top Type choose Surface conforming. 

c. Leave Extrusion Height set to Enter manually with a value of 0.00. 

d. Set Width to Enter manually with a value of 10.00, which will be the width of each stream in 

map units (feet in this example). 

6. You have now specified all the settings for streams.  Click OK to return to the Scenarios & Layers tab.  
Confirm that there is now a yellow cube with a green check next to Streams in the Layer List. 

 
Sunny Vista includes two different kinds of roads in the same Roads layer:  Main and Secondary.  In the next 

exercise you’ll see how to give each type its own 3D representation. 

 
1. On the 3D Scene Settings – 

Scenarios & Layers tab, 
double-click Roads in the 

Layer list. 
2. For the Substitution 

Method, choose Value-

based.  This means that 
different features will receive 

different 3D representations 
depending on the value of 

one of their attributes.   

3. For the Distinguishing 
Attribute, choose Type.  

Then click Add all values 

 to show the current 

unique values of the attribute 
called “Type” in the Roads 

layer. 
4. You will set up Secondary Roads first, then Main Roads.  Click on Secondary Road in the list of attribute 

values. 
5. For the Top Material, choose a gray color.   

6. For the Top Shape, set: 

a. Same for all models to cleared, because you want different widths for different types of road. 
b. Top Type to Surface conforming 

c. Extrusion Height to Enter manually with a value of 1.00.  This means the road will be 1 foot 
thick. 

d. Width to Enter manually with a value of 18.00.  Secondary roads will be 18 feet wide. 

7. To specify settings for the 1-foot-high vertical sides of the roads, click the Sides tab. Use the same 
Material color.  Check Same for all models and choose a Side Type of Join to top.  This makes the 

top edge of the sides align with the edges of the top surface. 
8. Click Apply.  Apply saves your current settings without closing the window. 

9. Now create settings for Main Roads.  Click on Main Road in the list of attribute values, then go to the 
Top tab and change Width to 28.00.  Make sure all other settings match those for secondary roads. 
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10. Click OK.  The Roads layer is now set up. 
 

You have now set up a terrain, a ground layer, streams, and roads.  You may wish to give yourself a “sneak 

peek” of your work so far using the directions above. (Click Export Now  and then click Launch Scenario 

3D Viewer .) Don’t be alarmed if roads take a couple of minutes to export.  Details on using the 3D Viewer 
come later in this tutorial. 

 

3D Scene Settings – Polygons 
Features that are polygons in 2D are also polygons of the same size in 3D.  They can be thin surfaces (either 

horizontal or surface conforming), extruded with a flat or surface-conforming top, or sides without tops (like a 

fence around a field).  In this exercise you’ll make a pond and extrude some building footprints. 

1. From 3D Scene Settings, double-click Ponds in the Layers list. 

2. Under Substitution Method, choose Single.   

3. Ensure you are working on the Top tab.  For Material, select Choose a texture.  Use the Browse  
button to open the Library Browser and select the Ocean material as you did with streams. 

4. Set the Shape settings as follows: 

a. Leave the check in the box called Same for all models.   

b. Ponds are flat, so for Top Type choose Flat. 

c. Put Extrusion Height set to Enter manually with a value of 5.00.  Extrusion is measured 
from the lowest vertex of the terrain to the top of the flat surface, so this will make the pond 5 

feet deep at its deepest.  Setting this value too low will make the pond disappear below the 

ground (except at the lowest point of the terrain); setting it too high will make the water surface 
float in the air.  In practice, getting the correct value may require a little experimentation. 

5. By default Sides are set to “no sides,” which is what we want, so no additional action is required.  Click 
OK to return to the Scenarios & Layers screen.  Confirm that there is now a yellow cube with a green 

check next to Ponds in the Layer List. 

 
Next, set up building footprints as extrusions.  Later you’ll set up building points as 3D objects, so you’ll have a 

chance to try both of these popular methods for putting buildings into a scene. 

6. From 3D Scene Settings, double-click 3D Buildings in the Layers list.  Note that this is a polygon layer 

representing the footprints of proposed buildings. 

7. Under Substitution Method, choose Value-based.   

8. For the Distinguishing Attribute, choose Land Use.  Then click Add All Values  to show the 

current unique values of the attribute called “Land Use” in the 3D Buildings layer.  You will see “Single 

Family Residential,” “Commercial,” and “Mixed Use.” 
 

9. Clear the checks from “(All other values)” and “Single Family Residential.”  Residences will be modeled 

with a different technique. 

10. Click on Commercial. 

11. Top tab: 

a. For Material, select Choose a color and pick a gray color to represent flat roofs.  

b. For Shape, check Same for all models.  This will automatically set “Mixed Use” buildings to the 

same settings.  Set the Top Type to Flat.  Set the Extrusion Height to Use field value and 
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choose Height.  “Height” is an existing attribute in the 3D Buildings layer that gives the height of 
each building.  In practice, you may have to set an approximate height manually. 

12. Sides tab: 

a. For Material, select Choose a texture.  Use the Browse  button to open the Library 

Browser. 

b. In the Library, go to the Textures folder and navigate to the Artificial/Buildings/Sides 

subfolder and choose façade_24.png. Click Open. 

(Textures can be graphics, photos, or any other image in GIF, JPEG, TIFF or PNG format.  You can use files from 

the Library or any other source.  If you take a digital photo of the side of a building, you can use it here.  You 

may need to use Texture Properties  next to the Preview window to adjust the image size properly.) 

c. Set the Shape settings to Same for all models checked; Side Type to Join to top. 

13. Make sure that Commercial and Mixed Use are still checked in the Distinguishing Attribute list.  Click 

OK to return to the Scenarios & Layers screen.  Confirm that there is now a yellow cube with a green 
check next to 3D Buildings in the Layer List.  

14. Click Apply to save your work so far. 

 
You have now seen how polygons can be set up as flat surfaces like ponds or extruded 3D objects like buildings.   

 
Note that in the same way you place images on the sides of extruded polygons, you can also place images on the 

sides of extruded lines.  This technique is good for billboards, fences, and images of far-off objects. 

 
You may want to take another “sneak peek” at your work.  Details on using the 3D Viewer come later in this 

tutorial. 
 

3D Scene Settings – Points 
Features that are points in 2D are usually represented as complex objects such as houses, trees, cars or people in 
3D.  Scenario 360 uses objects in KMZ, 3DS, or DAE (COLLADA) format.  A library of objects is provided, and you 

can also make or get your own.  In this part of the tutorial you will set up trees and houses. 
 

1. From 3D Scene Settings, double-click Trees in the Layers list. 

2. Under Substitution Method, choose Random.  This method lets you 
put in several different tree models without having to specify exactly 

which model goes with which point. 

3. Under Random Choices, click New Random Choice  to create an 

entry called New Random Choice in the list.  Click on this entry once 
to select it, then click to make it editable. Rename it Spruce.  Make 

sure its checkbox stays checked. 

4. Under Model, click Browse  to open the Library Browser.  Go to 

Library/Models/Nature and highlight the 
tree_colorado_spruce.kmz model.  Click Open. 

5. Look at all the Options but leave them set to their default values.  Click Apply to save your work so far. 

6. Return to Random Choices and repeat Steps 3, 4, and 5 to create first an Ash 

(tree_white_ash.kmz) and then a Maple (tree_bigleaf_maple.kmz). 
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7. Make sure that all three random choices are still checked on in the list.  Click OK at the bottom of the 3D 
Layer Settings – Trees screen to return to the Scenarios & Layers screen.  Confirm that there is now 

a yellow cube with a green check next to Trees in the Layer List. 
 

Next, set up 3D Models for the houses in the scene.  This exercise will skip the steps of setting up models for 

commercial and mixed-use buildings. 

8. From 3D Scene Settings, double-click 3D Building Centroids in the Layers list. 

9. Under Substitution Method, choose Value-based.  Choose the Distinguishing Attribute Land Use 

and click Add All Values .   

10. Click on Single Family Residential in the list of attributes.  Under Model, click Browse  to open 

the Library Browser.  Go to Library/Models/Residential and highlight the f0433.kmz model.  Click 
Open. 

11. Under Options, set Orientation to “Use this field” and choose the field Orientation.  This field gives the 
angle to the nearest road, in degrees, for each building, and it will ensure that buildings face the nearest 

road.  If you use Scenario 360, it is easy to create such a field (dynamic attribute) using the AngleTo 

function.  Leave the default values of 1.00 for Scale and 0.00 for Vertical Offset.  Click Apply to save 
your work so far. 

12. In this exercise, you will not set up models for Mixed Use and Commercial buildings.  You can always 
add them later if desired and they are currently being modeled with extrusions set up earlier, so you can 

clear their checks in the list here along with the box for (All other values).  Click OK at the bottom of 

the 3D Layer Settings – 3D Building Centroids screen to return to the Scenarios & Layers screen.  
Confirm that there is now a yellow cube with a green check next to 3D Building Centroids in the Layer 

List. 

13. Click OK to close 3D Scene Settings. 

You have now created a good set of 3D Scene Settings for your scene.  You have a terrain, a ground layer, and 
several of the most important feature layers.  It’s time to export the scene and go look at it. 

 

Export Now and Launch 3D Viewer 

From the Scenario 3D toolbar, click Export Now , wait for the progress bars to complete (this may take a 

few minutes) and then Launch 3D Viewer .  The 3D Viewer will open with your scene. 

 

If you did not make a scene, you can view one that has been made for you already.  From Windows Explorer, 
navigate to the Tutorial 4.scene file normally stored here:   

 

C:\CVFiles\Sunny Vista\3D\Tutorial 4.scene 
 

Double-click the file; this will launch the Scenario 3D Viewer application and open this scene. 

 

3D Viewer Navigation 
This part of the tutorial gives you a tour of the features in the Scenario 3D Viewer. You may wish to maximize the 

3D Viewer window for comfortable viewing.   
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There are several choices for moving around, or “navigating,” the scene.  You can choose among them using the 

Navigation  toolbar.  For a complete list of navigation commands and options, see the 

Help.  You will need a 3-button mouse:  left button, right button, and center scroll wheel.  The scroll wheel can 
be pushed down like a regular button or rolled. 

 

1. Start with the Maneuver  mode.  This navigation mode provides a quick, efficient way to move 

around and orient the scene.  Try gently dragging (holding down the button and moving) with each 

mouse button (left, right, and center) to see the different effects.  Scroll the middle mouse scroll wheel 
to zoom in and out.  Pick an object in the scene and the Ctrl+Left Click on it.  This makes that object 

the new focal point.  Notice it stays in the center of the scene as you zoom or left-mouse maneuver. 

2. To get back to the starting point and get your bearings, click Full Extent . 

3. Switch to the Fly  mode.  This aptly-named mode moves you gracefully through the scene and is 

good for giving yourself and others “tours” of the area.  Click and hold the left mouse button to move 

forward toward the cursor and steer by moving the cursor around the screen.  Click and hold the right 
mouse to go backward.  Roll the scroll wheel away from you or toward you to change your speed.  

Notice that your speed is shown in the display in the upper left. 

4. Switch to Walk  mode.  This keeps you at a constant height above the terrain as you move through 

the scene.  Use the keyboard keys “w,” “a,” “s,” and “d” to move laterally and use the cursor to steer.  

As with flying, you can change your speed with the scroll wheel and adjust your height by dragging 
with the middle mouse button pressed down.  Try “walking” to the pond to see the effect of the Oceans 
water material.  Set your height to about 6 feet and look for reflections of the mountains. 

5. Switch to Zoom  mode.  Double-click on an object in the scene and you will automatically be flown 

to it. 
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6. Switch to Select  mode.  Although you can use this mode for simple navigation, its real purpose is 

“selecting” or choosing features in the scene just as you would select features in ArcMap with a tool like 

ArcMap Select .  Just as in ArcMap, it may be helpful to choose the layers you want to select.  To do 

so, use Selection > Set Selectable Layers.  Select features by clicking on one or by dragging a 

rectangle that touches them.  They will be highlighted with a semitransparent box.  Find those features’ 

attribute values by clicking Identify . When finished, Close the Attribute window and clear the 

yellow highlight boxes using Selection > Clear Selection. 
7. The layer list on the left of the 3D Viewer works a lot like the one in ArcMap.   

a. Clear a few of the checkmarks to see the corresponding layers disappear from the scene.  Turn 
them back on when finished.   

b. (If you have more than one scenario (map or data frame) in your scene, right-click on a 
heading in the layer list and choose Activate to display a different scenario.) 

c. Change the transparency of one or two layers.  Click a layer name to highlight it, then move the 

Transparency   slider bar at the bottom of the list.  Notice that Trees look 

better when left slightly transparent.  

 

Environmental Effects 
The 3D Viewer allows you to introduce environmental effects such as lighting, shadows and fog into the scene.  

Unlike features in layers, these effects are not calculated by your GIS system; they are for display purposes only.  
Nevertheless, they can be helpful and informative. 

1. Open the Environment controls using the Environment Controls  icon or View > Environment 

Controls and look through the options available to you. 

2. Toggle the Sky on and off by clicking its check box.  Note that the background Sky, including the clouds, 
distant mountains, and sun, is a static image that you can never get close to or “touch.”  Leave the Sky 

on. 

3. Toggle Lighting on and off by clicking its check box.  With lighting on, change the Time of Day and 
notice the effect on the sides of 3D objects.  Leave Lighting on. 

Lighting is actually a property of objects, not the surrounding scene.  3D objects that have been given “lighting” 
properties have more shading on sides that face away from the virtual light source.  Objects without lighting are 

fully lit on all sides.  Paradoxically, “lighting” actually makes most objects darker, at least on some sides. 

4. Toggle Fog on and off.  With Fog on, move the Fog slider bar to change its density, which affects how 

far you can see.  For better perspective, try moving to Full Extent .  Turn fog off.   

5. Use the slider bar to change the View Distance.  This causes distant objects not to be drawn, which can 
improve performance in some cases.  For now, restore it to maximum distance. 

6. Toggle Shadows on and off and notice the effect.  The length and direction of shadows are determined 
the Time of Day and Latitude, which you can set separately.  Shadows fall only on ground images, not 

on surface-conforming polygons or other objects.  Leave Shadows on. 

 

Bookmarks 
Scenario 3D bookmarks save a particular location and viewing angle so that you can return to it later.  They 

provide a useful, easy way to save and find particular views. 
 

1. Navigate to an interesting position in the scene. 

2. Go to View > Bookmarks or use the Bookmarks  icon to open the Bookmarks window.   

3. Click New Bookmark .  Type the name My Interesting Place and click the Enter key on your 
keyboard. 

4. Navigate to a new position and create a second bookmark.  Notice that the bookmarks are listed in 

alphabetical order by name. 
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5. Highlight My Interesting Place in the list and click Go To Bookmark .  Watch the scene 
automatically navigate to the correct location.  (The speed of transition can be set in File > 

Preferences > Navigation.) 
 

Flythroughs 
Scenario 3D flythroughs are particular navigation paths that you have saved and can retrace or replay in either 
direction and at any speed.  They provide a useful way to give tours of your scene. 

 

1. Open the Flythrough Controls toolbar from the Flythroughs  icon. 

2. Click Create New Flythrough  to start the process.  Enter a name for the flythrough you are 

about to create. 

3. Click Start Recording  to begin the process of storing the current view. 
4. Navigate through the scene as desired, using any navigation tool. A timer appears just below the Start 

Recording button to show you how much time has elapsed.  Aim for 5 – 10 seconds. 

5. When finished, click Stop Recording .  The flythrough is now saved. 

6. Click  Rewind  and then Play  to run through the flythrough as if it were a movie. 

7. Use the Flythrough Slider  to move immediately back and forth to any 

time in the flythrough.  The timer at the right shows the current position in the flythrough’s overall 
timeline.  You can make and save multiple flythroughs if desired.  To delete a flythrough, use the File > 

Scene Properties… > Flythroughs tab. 

 
 

Hyperlinks 
One benefit of Scenario 3D scenes is that they are “information rich.”  If you are making a scene to show other 
people, you may want them to be able to click on objects and get a photo, an audio recording, a website, or 

some other media telling them more.  Maybe you’d like your viewers to be able to click on a person and hear the 
person “talk” with a recorded voice.  Hyperlinks help you make this happen. 

 

Here is an example. 
1. Make sure 3D Building Centroids are selectable using Selection > Set Selectable Layers. 

2. Navigate to a place where you can comfortably view some of the houses in this layer. 
3. Hyperlinks are not active in a scene until you set them up.  Right-click on the 3D Building Centroids 

layer in the list and choose Properties….  You may have to wait a moment for this window to appear. 
4. In the Hyperlinks drop-down, choose the attribute field Website.  This is a text attribute we created in 

the 3D Building Centroids  layer that contains the full path name of the website we want to open. 

5. Click the Hyperlink  icon in the navigation toolbar. 

6. Hover the cursor over a particular house and wait for yellow highlighted text to appear. 
7. Click.  Your computer should recognize the weblink and open your default web browser to the correct 

page, www.communityviz.com. 

 

Movies 
The best way to experience Scenario 3D scenes is with the 3D Viewer.  However, if you want to share a model 

with other people who do not have access to the 3D Viewer, recorded movies (videos) may be a good alternative.  
They allow you to record the view as you navigate through the scene, usually by following a preset flythrough 
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path.  When finished, movies are stored as a stand-alone *.avi or other files that can be freely shared with 
others. 

 
Movie files can quickly become very large.  Use caution when recording and plan ahead if possible.  

 

1. Open the Flythrough Controls  toolbar. Make sure that the name of an existing flythrough is 

showing.  

2. Click Movie Recorder . 

3. When prompted, enter a name for the movie you are about to create.  Click Save.  A movie of your 

flythrough will be created.   
4. To view the movie, use Windows Explorer to navigate to its location and double-click it.  The default 

directory for movies is C:\Users\<username>\Documents\Scenario3D\Movies.  Your computer’s 
media player should launch it automatically. 

 

Movies can also be created “free-hand” without using a flythrough, but quality may suffer.  Use View > Movie 
Recorder.  If you have trouble creating or viewing the movie, you may need to adjust your default recording 

settings via File > Preferences > Movies. 
 

Congratulations – you have completed Tutorial 4 
This tutorial has given you a tour of many, but not all, Scenario 3D features in the 3D Exporter and 3D Viewer.  
We recommend you look back through the steps to review the Scenario 3D features you used and reflect on the 

overall approach to the 3D modeling, focusing more on the functions than on the exact buttons and steps.  For 
more information on features, tips, and details, look through the Help system available from the Help menu. 
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Tutorial 5 – Setting up and running a build-out analysis  

This tutorial walks you through creating and running a detailed build-out analysis.  For a simpler introduction to 
the basics of build-out, use Tutorial 1.  

 
Build-out analyses allow planners to estimate the amount and location of development for an area. 

Performing a build-out analysis is the step in the community planning process that identifies the holding 

capacity of the land in terms of buildings and/or floor space.  Build-out is a supply-side calculation applied to a 
clearly delineated area that is based on assumptions for density, physical constraints to development, and land-

use regulations that define the size and placement of structures for that area.   
 

A build-out analysis provides an answer to the question “how many buildings could be built in this area according 
to current land-use regulations?”  A build-out analysis provides a convenient reference for future planning 

because it represents a theoretical maximum.  It does not imply or forecast how many buildings will actually 

be built. 
 

In this fictional example, you will run a build-out analysis on a study area containing multiple land-use 
designations. 

 

Once installed using the “Install the tutorial data” directions, you will find this analysis in the CVFiles\Build Out 
folder. For detailed information on build-out, please see the “Working with the Build-Out Wizard” document 

available separately. 
 

Data requirements for Build-Out 
Before running a Build-Out, you will need: 

• A land-use layer (like a zoning map, master land-use plan, or a parcel map).   

• This land-use layer must be a projected coordinate system as opposed to a geographic coordinate 

system.  More information on coordinate systems can be found in ArcMap’s help or at the ArcGIS 

website. 

• The land use layer must have an attribute that specifies the land-use designation (like zoning type, 
permitted use description, or land-use code) as a text field (not numeric) and cannot exceed 100 

characters. 

• The land-use layer must have an attribute that specifies the unique identifier of each land-use area 
(like feature ID or parcel number). 

You will be prompted for this information as you move through the Build-Out Wizard. 

About build-out analysis 
A build-out analysis is one the many kinds of analyses that are possible with Scenario 360. In the fictional study 

area, differing land-use designations will be considered for future planning. The build-out process contains 3 
separate, but integrated steps: numeric, spatial, and visual. In this tutorial, you will experiment with all three. 

 
Objective 

• Estimate how many buildings could be built in the study area according to current land-use regulations. 

• Place the estimated building points in your map view while taking into account the actual geometry of 
land-use areas and buildings. 

• Visualize the buildings in 3D. 

 

Constraint 
Proximity to wetlands environmental area. 
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Opening an existing analysis 
1. If you haven’t already, start Scenario 360 by double-clicking 

on the Scenario 360 icon on your desktop. If Scenario 360 is 

open, click the Start a Scenario 360 Analysis button on 
the Scenario 360 toolbar. 

2. On the Welcome to Scenario 360 window, click Open 
Existing Analysis. 

3. Browse to the CVFiles/Build Out file, click the file, and click 

OK. If you had a previous analysis open, you will be prompted 
to save your changes. 

 
 

 
 

 

 
Scenario 360 will load and display a fictional study area being considered for development. This area displays 

eight land use designations: 
 

• Low Density Residential 

• High Density Residential 

• Mixed Use A 

• Mixed Use B 

• Mixed Use C 

• Commercial 

• Municipal 

• Park/Openspace 
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The land-use rules for this fictional analysis are included in the table below. In this tutorial, you will be walked 

through entering this information into the Build-Out Wizard to run your build-out analysis. 

 

Land-Use Designation Density Mixed Use  Building Info Min Separation 
Distance 

Commercial .25 FAR  0 DU/Building 
10000 sq. ft. 

1 floor 

100 feet 

High Density Residential 14 DU/acre 
80% efficiency 

 6 DU/Building 
4 floors 

80 feet 

Low Density Residential 0 DU/acre 

(already built) 

 0 DU/Building 

0 floors 

0 feet 

Mixed Use A 3 DU/acre .2 FAR 

50/50 % split 

 1 DU/Building 

1400 sq. ft. 

3 floors 

80 feet 

Mixed Use B .65 FAR Apartments = 30% and 

1200 sq. ft 

Retail = 20% 
Office = 50% 

0 DU/building 

2800 sq. ft. 

5 floors 

80 feet 

Mixed Use C .3 FAR Apartments = 75% and 
1000 sq ft 

Retail = 25% 

0 DU/Building 
4000 sq. ft. 

2 floors 

100 feet 

Municipal .3 FAR  0 DU/Building 
3 floors 

 

40 feet 

Parks/Openspace  0 DU/Building 
0 floors 

 0 

Opening the Build-Out Wizard 
The Scenario 360 Build-Out Wizard automates the entire build-out process. It guides you through the choices and 
selections that will form the basis of your build-out analysis. You can access the Build-Out Wizard using the 

Scenario 360 toolbar. Click the Scenario 360 drop-down list, point to Tools, and click Build-Out Wizard. 

 
For this tutorial you will used the Advanced version of the Wizard.  Click the Advanced button on the Welcome 

screen. 

Setting up a numeric build-out analysis 
For a numeric build-out analysis, the Build-Out Wizard will calculate the estimated building capacity (in numbers) 

for each polygon in an area. 
1. Open the Build-Out Wizard. 

2. Click the Numeric button. 

Specifying land-use information 

When following the numeric Build-Out Wizard steps, you will be prompted to specify: 

• A land-use layer (like a zoning map, master land-use plan, or a parcel map). This must be a projected 

coordinate system (as opposed to a geographic coordinate system). For information on coordinate 
systems, see ArcMap help. 

• The attribute in that layer that specifies the land-use designation (like zoning type, permitted use 

description, or land-use code). This must be a text field (not numeric) and cannot exceed 100 characters. 

• The attribute that specifies the unique identifier of each land-use area (like feature ID or parcel number). 

 
In this tutorial, the data has been set up for you. 

1. On the Specify Land Use Layer screen, ensure that Land Use is selected as the layer containing land 
use information; 
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2. The attribute specifying land-use designation should read LU_Designation. 
3. The attribute specifying the unique identifier of each land-use area should read OBJECTID. 

4. Preview the land-use designations in the field provided, then click Next. 

Setting up density rules 

Density is an indication of the number of buildings per unit area. Attributes specifying land-use designations may 

contain fields that describe the permitted (or projected or planned) densities in each polygon. For residential 
polygons, density is often provided in dwelling units per area, number of dwelling units, or minimum lot size per 

area. For nonresidential polygons, density is usually provided in floor area or by using a floor area ratio (FAR). If 
these fields are not provided, you may enter numbers for each land-use type in the Build-Out Wizard, or use the 

default values suggested by the Wizard. 

1. Either type or click and select from a provided drop-down list to fill in the fields with the information 
shown in the image below: 

 

2. Do not exit the Wizard or click Next at this time. 

Using the FAR Estimator 

Sometimes, land-use regulations don’t specify FAR but instead use other rules such as minimum set back from lot 

lines and maximum building height. The Build-Out Wizard includes a FAR Estimator to help you derive FAR from 
other commonly used land-use rules. You will use the FAR Estimator to calculate FAR for the Mixed Use A and 

Municipal designations. 

 
Calculating FAR for the Mixed Use A designation: 

1. Click the FAR Estimator button on the Density Rules Wizard screen. 

2. Click the Lot Size/Setback tab, click to place a checkmark next to Average lot size is sq. feet or sq. 

meters and type 1400 into the field provided. Note, the FAR Estimator does not need to know which 
measurement system (feet or meters) you are using, but you must be consistent. 

3. Make sure there is a checkmark next to Building setbacks in sq. feet or sq. meters and type 30 in 

the Front setback field. 

4. The FAR calculation at the bottom of the window should read .2. 

5. Click to select Mixed Use A from the Apply to land-use designation drop-down list then click Apply. 
 

Calculating FAR for the Municipal designation: 

1. Click to remove the checkmarks on the Lot Size/Setback tab then click the Buildings tab. 

2. Click to place a checkmark next to Maximum building heights and type 3 for the number of floors 

allowed. 

3. Click to place a checkmark next to The building coverage ratio and type 10 in the field provided. 

4. The FAR calculation should read .3. 

5. Click to select Municipal from the Apply to land-use designation drop-down list then click Apply. 
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6. Click the Close button to close the FAR Estimator and view the FAR calculated for the Mixed Use A and 
Municipal designations on the Wizard screen. Verify that your numbers match those in the image below. 

Do not exit the Wizard or click Next at this time. 

 

Specifying mixed-use designations 

Build-out can apply to residential dwelling units (DU) and/or commercial or mixed-use buildings. Mixed-use 

buildings can include both DU and commercial space. In your study area, Mixed Use A is a mixed-use land area 
with some all-residential buildings and some all-non-residential buildings. Mixed Use B includes mixed buildings 

with apartments, retail, and office space. Mixed Use C includes buildings with apartments and retail space. When 
using the Wizard for mixed-use buildings (as in these two examples), the number of dwelling units is specified in 

the mixed-use screens shown below – not in the density screens. This way, even though the density screen says 

0 DU/acre, the residential units within mixed-use buildings will still be counted in your analysis. 

1. Place a checkmark next to the link One or more designations include mixed-use buildings on the 

Density Rules Wizard screen and click Next. 

2. In this analysis, two of your mixed use designations include mixed use buildings. Click to place a 

checkmark next to the Mixed Use B and Mixed Use C designations and click Next. 

3. Make sure the units drop-down list under Floor Area per DU has sq feet selected. Then, using the 

information provided in the image below, type the Building Use field information and the Percent of 

Floor Area per DU information for Mixed Use B in the fields provided. 

  

4. Ensure that your building use percentages add up to 100% and click Next. 
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5. Make sure the units drop-down list under Floor Area per DU has sq feet is selected. Then, using the 
information provided in the image on the next page, type the Building Use field information, the 

Percent of Floor Area, and the Floor Area per DU information for Mixed Use C in the fields provided. 

 

6. Ensure that your building use percentages add up to 100% and click Next. 

7. Because you entered both residential (DU) and commercial (FAR) uses for the Mixed Use A designation, 
you are given the option to specify the percentages of land area that will be considered when calculating 

densities for residential and commercial use. On the Mixed-Use Percentages Wizard screen click the 

radial button to select Specify smaller percentages, then type 50 into the Dwelling Units Percent 
field and 50 into the Floor Area Percent field.  (If you leave these percentages at 100 each, the tool will 

calculate the number of residential units and commercial floor per polygon independently, using the 
densities you gave on the Densities screen and the entire area of the polygon.) 

8. Click Next. 

Using efficiency factors 

Efficiency factors adjust density values to reflect common density losses. They are entered as a percentage where 

100% means complete efficiency (no density lost), and 0% means no buildings will be estimated for that land 
use. In this fictional analysis, the High Density Residential designation requires 10% of the area to be dedicated 

to roads and 10% to schools. Therefore, you need to enter efficiency information for this designation. 

1. Click to select the Customize efficiency for each designation option. 

2. For the High Density Residential land-use designation, type 80 in the Efficiency Percent field and 

click Next. 

Entering building information 

The Building Information Wizard screen allows you to set up building size, dwelling units per building, and 

footprint of each building. 
1. Make sure the units drop-down list under Area has sq feet selected. 

2. Using the information provided in the image below, type the DU per Building, Area (in sq. feet), and 
the Floors in the fields provided then click Next. Again, note that Mixed Use B and C correctly show 0 

DU per building on this screen because their dwelling unit numbers are calculated by a different method. 
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Specifying constraints to development 

The “Constraints to Development” screen allows you to prevent development in particular places, such as a 

designated wetlands area or a right-of-way.  For this example: 
 

1. In the Available Layers list, click Wetlands, click the Add selected layer(s) to constraints button, 
then click Next. 

 

The wizard also provides the ability to specify a minimum lot size, so that a polygon that is too small is not 
allowed to have any buildings.  For this example you will not use that option. 

 

Specifying existing buildings 

If an area is zoned for 100 buildings but already contains 15, then you may want to limit your study to the 85 

new buildings that are allowed.  The build-out wizard can automatically subtract existing buildings from its results 
if you specify a point layer containing them.  Normally each point is considered to be one dwelling unit, but if the 

layer contains attributes that specify a particular number of dwelling units per point, or a commercial floor area 
per point, you can use them here. 

1. In the Available Layers list, click Existing Buildings, then click the Add selected layer(s) to 

existing buildings button. 

2. In the Value or attribute specifying DU/bldg field, 

select DUs from the drop-down list. 

3. In the Value or attribute specifying floor area 

measurement drop-down list, make sure sq feet is 

selected, then select FootPrntSF from the drop-down 
list in the field provided. 

4. Click Next. 

Running a numeric build-out analysis 

You can run a numeric build-out analysis by itself or as the first step in running a spatial or visual build-out 

analysis. In this tutorial, you will run the numeric build-out, view the results, then continue on to spatial build-out. 

1. Ensure the output units for the available floor area read sq feet. 

2. Click on Finish on End of Numeric Phase window to Finalize set up of numeric build-out and continue 
to the next step. 

3. Make sure that only Numeric is selected (it has a checkmark next to it) and click Run Build-Out on 

Finish window. 
 

Numeric build-out will now convert your land-use information (like density, design efficiency factors, and 
constraints to development) into numeric building counts. Running this numeric build-out analysis produced: 

• Two new layers viewable in the Build-Out layer in the ArcMap table of contents. One is called Buildings 

and the other is Buildable Area. You can click and drag the Build-Out layer set beneath the Existing 
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Buildings and Roads layers in the ArcMap table of contents to view existing buildings and roads in your 
map view. 

• A Build-Out LandUses table. You can click the List by Source tab, right click on the Build-Out 

LandUses table and click Open on the pop-up menu to view the contents of this table. 

• Six indicators. Click the List Indicators button on the Scenario 360 toolbar to view the new indicators. 

• A Build-Out report. Click the List Reports button on the Scenario 360 toolbar then click on the report 
name to view the report. 

• Three new charts: Build-Out Dwelling Units, Buildings, and Floor Area. Click the View Charts 

button on the Scenario 360 toolbar to open the charts view.  You may  

• A new Buildings Difference Buildable Area alert. Click the List Alerts button on the Scenario 360 
toolbar then click Show all alerts to view the alert.  You may need to Run All Alerts. 

 

 

 

Setting up a spatial build-out analysis 
Spatial build-out will create a new point or polygon layer representing individual buildings placed on the map 
according to your land-use rules.  Spatial build-out can take a long time so it’s a good idea to try some initial 

experiments with a hundred buildings or less before working with larger numbers.  Settings in the Spatial Layout 
window are vital to the final spatial build-out results.   

 
Spatial build-out converts the numeric building counts into points representing individual structures. It then 

refines the numeric building counts by taking into account the actual geometry of land-use areas and buildings. 

For example, an oddly shaped lot may have enough total area for 2 buildings, but because of setback rules or 
minimum separation distances, it may only fit 1 unit. You must first run a numeric build-out analysis (to get the 

numeric building counts) if you wish to run a spatial build-out analysis. 

1. Open the Build-Out Wizard. 

2. Click the Spatial button. 

Six new 
indicators A build-out report 

An alert 
Three new 

charts 

A Build-Out 

LandUses table 

Two new layers viewable in 

the Build-Out layer in the 
ArcMap table of contents 
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Specifying building separation distances and choosing a layout pattern 

When setting up a spatial build-out analysis, you will be prompted to specify building minimum separation 

distance rules for your land-use designations. Building separation identifies the minimum distance required 
between building centroids.  

 

The minimum separation distance defines the minimum distance between a new building point/polygon 
center and another existing or new building point or polygon center.  Also, a new building point will be separated 

from its containing polygon’s edge by at least half the minimum separation distance.  If you set the Minimum 
Separation Distance too large, no buildings will be allowed.  Therefore it’s best to begin conservatively with a 

smaller distance that you can increase in later runs.  Settings are retained from one run to another, so you can 

skip other windows that contain values you don’t want to change. 
 

In choosing a Layout Pattern for the proposed buildings, “Random” is a good layout pattern to start with.  If you 
use the Follow Roads layout pattern, you must specify a Setback distance. The setback is the exact distance 

from the road centerline to the building point or building polygon center. Setback distances are ignored when the 
grid or random layout pattern is used.  

 

Tip: Setback distances should be greater than the distance from the road centerline to the edge of the land-use 
polygon PLUS half the minimum building separation distance.  Otherwise, no building will be placed.  

 

 
You have control over whether the spatial build-out building points are distributed in a random or grid pattern, or 

if you want the points to follow a road layer. 

1. Make sure the units drop-down list under Minimum Separation Distance has feet selected. 

2. Make sure the units drop-down list under Setback has feet selected. 

3. Using the information in the image below, type or click and select from a provided drop-down list to fill in 
the Minimum Separation, Layout Pattern, Road or Line Layer, and Setback fields. 
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4. Click Next. 

Running a spatial build-out analysis 

Each time you run a new build-out analysis on a given scenario, the old build-out analysis for that scenario will be 
overwritten. To explore and compare different alternatives without overwriting your previous results, you are 

given the option to create and use new scenarios in your analysis. For example, you may want to compare “build-
out if we impose more restrictive zoning” versus “build-out if we create an enterprise zone”. In this tutorial, we 

will run each build-out step and overwrite the previous results. 

1. Move the slider bar to 100. This is a small study area and will not take a long time to process. 

2. Click on Finish next to the Finalize set up of numeric and spatial build-out and continue to the 

next step option. 

3. Make sure that only Numeric and Spatial are selected (they have a checkmark next to them) and click 

Run Build-Out. 

4. A pop-up window will ask whether you want to overwrite existing build-out results.  Select Overwrite 

the current results and click OK. 

Spatial build-out analysis results 

Spatial build-out converts the building counts estimated during numeric build-out into points representing 

individual structures you can view on your 2D map. Potential building points are distributed two-dimensionally 
into each polygon one at a time. Spatial build-out places building points so that they avoid development 

constraints, other buildings, and polygon boundaries (land-use areas, zone districts, or lot lines). 

Spatial build-out analysis takes into account factors which cannot be accounted for in a numeric estimate, such as 
the minimum allowable offset between building or parcel shapes. Therefore, the results of spatial build-out are 

sometimes lower than the numbers derived in a numeric build-out. 
 

Keep in mind the following when viewing the results of a spatial build-out analysis: 

• A new building point will be separated from another new building or any existing buildings point in the 

same polygon by at least the minimum separation distance specified for that polygon’s land-use class. 

• A new building point will be offset from its containing polygon’s edge by at least half the minimum 
separation distance specified for that polygon’s land-use class. 

• If a building does not appear in a polygon when you expect one to appear, or if fewer buildings are 

added than there is capacity, examine the attributes of the polygon. Was an estimated capacity correctly 
computed? Are there more existing buildings in the polygon already than there is capacity? Also, examine 

the dimensions of the polygon. Perhaps the minimum offset distance is too large. 

• After spatial build-out has been run, you are free to edit the new buildings layer manually. You can add, 
move, or delete building points. This way you can turn a planning-level building pattern into more of a 

design-level distribution, with buildings following a uniform frontage line, etc. 

 
Running this spatial build-out analysis: 
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• Populated fields in the Buildable Area attribute table and the Build-Out LandUses table. Right-click 

on the Buildable Area layer in the ArcMap table of contents and click Open Attribute Table to view 
the contents of this table. You can also click the Source tab, right click on the Build-Out LandUses 

table and click Open on the pop-up menu to view the contents of this table.  You map may not match 
this picture exactly.  There is some randomness in each run of spatial build-out. 

• Added information to the Build-Out report. 

• Updated the Spatial information in the charts created during numeric build-out. 

• Triggered the Buildings Difference Buildable Area alert created during numeric build-out. Click the 

List Alerts button on the Scenario 360 toolbar, click to select the Show only alerts that are 
currently active option, then click Run all alerts to view the alert. The alerted area is displayed in the 

map view with a bold outline. It has been colored red in the image on the next page to highlight the 

area. 
 

 

Setting up a visual build-out analysis 
Spatial build-out placed the building points onto the 2D map. Visual build-out designates a building model (flight) 

file for those building points that can be viewed in a 3D scene. Therefore, you must first run spatial build-out 
(which requires you to run numeric build-out) before running a visual build-out.  

 
There are three options for models that you can use with visual build-out.   

A. Using models from the CommunityViz Model Library, suitable for viewing in Scenario 3D or Google Earth.  

B. Using models created in SketchUp® or downloaded from Trimble’s 3D Warehouse, and also suitable for 
use with Scenario 3D or Google Earth. 

C. Using models you create or obtain yourself, in 3DS, DAE, or KMZ format. 
 

To learn more about these options, read this section.  To continue with the tutorial, skip to the section "To 

conduct a visual build-out" below.   

A. Using models from the CommunityViz Model Library: 

The CommunityViz Library contains a useful collection of pre-made KMZ-format 3D models that can be 
used in Scenario 3D or Google Earth in conjunction with the CommunityViz Google Earth Exporter.  

Alert triggered to notify you that 
not all buildings estimated during 
numeric build-out were able to 
be placed (see the Buildable 

Area attribute table Buildings 
Difference field). The alerted 

area is displayed with a bold 
outline in the map view 

Spatial results 
displayed in charts 
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Normally these files are installed in C:\CVFiles\3D Models\KMZ or in C:\Program Files 
(x86)\CommunityViz\Scenario 3D\Library. 

B. Using models created in SketchUp or downloaded from the 3D Warehouse: 

 Google operates a warehouse of 3D models provided by the public intended for public use. Go to: 

 https://3dwarehouse.sketchup.com 

 
 At this website, you can search for a model representing the building type you desire, e.g. schoolhouse, 

 and click on "Download  to SketchUp."  Once you are in SketchUp, export the image to a  .KMZ file, 
saving it to the C:\CVFiles folder where your analysis is stored, e.g. C:\CVFiles\Sunny Vista.   Later you will 

navigate to this location to use this image. Go to:  

 http://www.sketchup.com/ 
 

 Once at this website, go to the "Downloads" tab where you can download the software SketchUp for free.  
 Use the tutorials or SketchUp instructions to learn how to create your own model.  Once satisfied with 

 your model, export the model to a .KMZ format, saving it to your analysis folder, e.g. C:\CVFiles\Sunny 
 Vista. Later you will navigate to this location to use this image.  

C. Using models you obtain or create yourself: 

Scenario 3D supports files in KMZ, 3DS, and DAE (COLLADA Interchange) formats.  Google Earth 
supports files in KMZ format.   

To conduct a visual build-out:  

1. Open the Build-Out Wizard. 

2. Click the Visual button. 

3. Click once in the 3D Model field next to Commercial then click the Browse button . 

4. Navigate to the location on your hard drive where your models are located.   

▪ To use the pre-made CommunityViz KMZ models (for use in Scenario 3D or Google 
Earth), go to C:\CVFiles\3D Models\KMZ or to C:\Program Files 

(x86)\CommunityViz\Scenario 3D\Library. 

▪ If you saved SketchUp or 3D Warehouse models in your analysis folder, you can look 

there, e.g. C:\CVFiles\Sunny Vista\data.   

  

https://3dwarehouse.sketchup.com/
http://www.sketchup.com/
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5. Browse for a suitable building, click once to select it, and then click the Select button. Use the CTRL key 
to select multiple buildings. 

6. Continue steps 3-5 for all of your building layers (you do not have to select a model for the 
Park/Openspace layer). When you have completed selecting models, click Next. 

Running a visual build-out analysis 

1. Make sure that Numeric, Spatial, and Visual are selected (they have a checkmark next to them) and 
click Run Build-Out. 

2. Click Run Build-Out.  A pop-up window will ask whether you want to overwriting existing build-out 
results.  Select Overwrite the current results and click OK. 

Visual build-out analysis results 

Visual build-out provides a convenient way to populate the 3D model file field in the buildings layer created 
during your spatial build-out analysis. You can use this field when you create a 3D model of your scene in 

Scenario 3D, as described in the Scenario 3D Tutorial, or in Google Earth, as described in the  Google Earth 
Export Tutorial.  To use the building models you specified in visual build-out: 

 
In Scenario 3D: 

1. In 3D Scene Settings on the Scenarios & Layers tab, double click the Buildings layer to set 

its properties 
2. Under Substitution Method, choose Model Attribute 

3. Under Model Attribute, select the attribute called 3D Model. 
4. Optionally, adjust any Option settings.  These will be the same for all models in this layer. 

5. Click OK. 

 
Set up the rest of the Scenario 3D scene normally.  When ready, click Export Now on the Scenario 3D toolbar to 

create your scene, then view it with the Scenario 3D Viewer. 
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In Google Earth: 
1. In the Google Earth Exporter on the Layers tab, select the Buildings layer 

2. Export Layer as 3D Model 
3. For 3D Model Settings, choose Get 3D model file from a field 

4. Choose the Model File Field called 3D Model.  You can use the 3D models generated by visual 

build-out in either Scenario 3D or Google Earth, but not both at once.  If you want to use both 
3D tools, use another method for specifying which 3D model will be used for each build-out 

building. 

Set up the rest of the Google Earth export normally.  When you Export Now, the models you have specified will 

appear in the Google Earth scene. 

Exploring further 
This is the end of the programmed exercises for build-out, but you should feel free to experiment and explore 

further.  You can go back to the Build-Out Wizard and change any of your values then re-run build-out to view 
your new results. 

Congratulations – you have completed Tutorial 5 
This tutorial has taken you through a sample build-out analysis using Scenario 360. You have set up and run 
numeric, spatial, and visual build-out on this analysis.  We recommend you look back through the steps to review 

the Scenario 360 features you used and reflect on the overall approach to the analysis, focusing more on the 

functions than on the exact buttons and steps.   
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Tutorial 6 – Run an Analysis and Create a Presentation 

This tutorial will walk you through several different ways of presenting your analyses which you can use in any 
combination.  You will learn how to create clear, interactive, and impressive presentations using web-ready 

analyses, reports, and WebShots.  In addition to these, consider viewing and sharing your analyses using the 
3D visualization tools including Scenario 3D and the Google Earth Exporter.  

 

In order to have results to present, the first step is to create an analysis using the skills you have learned in 
previous tutorials.  Consider it a challenge! 

 

A challenge: run and modify an analysis  
1.  Using the Communityville data set, run a Suitability Analysis using the Suitability Wizard, creating two 

suitability factors and making the factors weighted:  

• Proximity to wetlands using lower suitability scores with closer proximity to wetlands 

• Proximity to nests using lower suitability scores with closer proximity to nests 
 

2. Examine the pie chart in the chart display.  What is the relative weighting of the two suitability factors, 
proximity to wetlands and proximity to nests?  Using the variable assumptions, change the weighting of 

the proximity to wetlands to be 8 out of 10 or 80% and the weighting of the proximity to nests to 2 out of 

10 or 20%.  Check that these changes are updated on the chart. 
  

3. Open the Properties of the Proposed 
Buildings layer and go to the Symbology 
tab.  Show Quantities  Graduated 

colors, and select Suitability as the Field.   
 

  Click on the heading called Symbol in the 

table and select Properties for all 
symbols.  Select a symbol called Square 1 

and change the symbol size to be 12.00. 
Click OK.  All of the symbols in the table will 

be black squares. 

 
 Now select a red to green color ramp.  The 

higher values which represent more suitable 
sites should be green and the lower values 

should be red.  If they are not, then click on 
the Symbol column in the table and select 

Flip Symbols.  This will reverse the order of 

colors. The symbology table should look like the one displayed here.   
 

 Click Apply and look at the map.  Do the results make sense? 
 

4. Now run the Common Impacts Wizard, deselecting the impacts affecting commercial areas, of which there 

are none in this analysis.  Otherwise accept all of the defaults and click Finish.   
 

5. On the 360 Analysis tab, click on Reports.  There is a report listed called "Communityville Common 
Impacts." Double-click on it to open it.  Examine the contents displayed in the report. Notice that it is being 

displayed in your browser and that it was saved in HTML format so that you can display it on a website if you 

like. 
 

6. Change the Active Scenario to Rural and examine the map.  Change it back to the Village scenario. 
  

7. Change the Chart display to be Compare by All Scenarios. 
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8. Note:  If you want to return the map to its original appearance, go back to the Symbology tab of the 
Layer Properties window and change it to Show: Categories  Unique Values, selecting "Suitable" for 

the Value Field.  Click on "Add All Values" below the table, and then modify each symbol by double-clicking 

on it to open the "Symbol Selector" window.  Change the symbol with the value of 0 to be a red square 
and the symbol with the value of 1 to be a green square.  You can select the shape and size first and modify 

the color after.  Click "Apply" at the bottom right of the Layer Properties window to see if you like the 
results.  

 

Organizing and displaying analysis information 

9. Click the Organize  button above the charts and change the order of the charts to be as follows for the 

top several charts:  

 

 
 
 

Close the Organize Charts window, and examine the chart display.  

  
10. Why does the village scenario have a much higher total household energy usage than the rural scenario? 

 
What is the population of each scenario? Given the populations, which scenario has a higher cost of 

building roads per person? 

 
11. Examine the chart displaying the Annual CO2 auto emissions.  Which scenario currently would emit more 

CO2 auto emissions, the rural or village scenario?  Once you have determined the answer, click on the 
Assumptions icon on the 360 Analysis tab, and change the assumptions for each of the scenarios to the 

following, clicking the apply button when done: 
 

Village Scenario 
Vehicle Trips per Day  to 8.0 

Average vehicle trip length  to 3.0 miles 

 
Rural Scenario 
Vehicle trips per day to 10.0 

Average vehicle trip length  to 12.0 miles 

 
Examine the charts.  How does the annual CO2 auto emissions compare by scenario now that you have 

changed the vehicle trips per day and average vehicle trip length for the rural and village scenarios?  
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Creating and using saved views 
12. Arrange the view to look approximately like that below. 

 

 

 
 

13.  Once you have your analysis set up, create a saved custom view of your current display 
by clicking the 360 Analysis tab Saved Views icon (see right) or by clicking the Open 

or Save a View  toolbar button on the Decision Tools toolbar. Then simply click the 

New Saved View  button and enter a name for it, such as "Village Suitability 

Analysis."  It is often desirable to save the layer symbology you are currently using as well.  To do so, place 
a check in the box called “Save layer symbology for the selected layers” and then place a check next to the 

layers whose symbology you want to save.  You can use Ctrl+click to select all.  If you only want to save 
symbology and not the rest of the view, use the Symbol Saver  on the Presentation toolbar or menu. 

 
This saved view is a snapshot of the screen as it is displayed right now that you can call up in Scenario 360 at 

any time, and can be used to illustrate different scenarios to community members. 

 
To view previously saved views, simply click on the Saved Views button and select from the list. 

 

Creating a web-ready report 
Now you will generate a professional report in HTML format, ready for hard copy publication or web site posting.  

The Reports Wizard will guide you through the reports process, allowing you to customize your report.   
 

Scenario 360 web-ready reports are now more flexible, allowing the viewer to customize the report in real time 

and providing for charts that compare all scenarios in an analysis. 
 

1. Click the 360 Analysis tab Reports icon or click the List Reports  toolbar button. 

2. Click the New Report button. 

3. Choose the "Detailed scenario comparison" (see figure below) 
4. The Reports Wizard will guide you through the reports process, allowing you to customize your report.  

For this tutorial, accept the default settings.  This will require you to leave many fields blank, selecting 
Next as you move through the steps.  
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5. Completed reports are 

saved in the analysis 
folder Reports 

directory.  Within the 
Reports directory, all 

pictures included in 
your report (such as 

charts and maps) are 

saved in an Images 
folder.  You can 

import these images 
into any presentation 

or document 

(including PowerPoint 
presentations and 

Microsoft Word 
documents).  

 
6. When you are 

finished with your 

report, you will be 
returned to the 

Reports window.  
Click on the name of 

your new report (the default name is Communityville Scenario Comparison) to open it.  This report 

is a stand-alone file that you can copy and share with friends.   
 

Note: Within the Reports directory, all pictures included in your report (such as charts and maps) are saved 
in an Images folder.  You can import these images into any presentation or document (including PowerPoint 

presentations and Microsoft Word documents). Its default location is: 

 
C:\CVFiles\Communityville\Reports\Communityville Scenario Comparison\Report.htm. 

 
7. When you are finished, close ArcMap and Discard Changes. 

 

Creating WebShots  
This section will take you through the steps of creating WebShots.  WebShots are HTML files preserving 

snapshots of your analyses that you can display on a website as a slide show or in a partly interactive 
format.  Viewers of the interactive website can change scenarios with a limited ability to change assumptions 

and see the results.  The web pages produced by WebShots allow viewers to see your analysis in two modes: 

 

• Slide show mode displays a series of screen images in the order you specify 

• Explore mode allows viewers to choose the scenario they are viewing and to vary assumptions.   
 

It is important to run the WebShots Wizard after having created all the scenarios and variable assumptions you 
think you will use, as the Wizard does not detect any analysis changes made after it has been run;  you will need 

to run it again if you do more analyses.  

 
The WebShots Wizard will let you choose: 

➢ Up to 5 scenarios to display 
➢ Up to 5 assumptions that you will be able to vary 

The options available 
in each report type 
are marked with a 

green checkmark. 
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➢ Up to 5 discrete settings for each variable assumption (in addition to its default setting) 
Assumption values that are not varied in your WebShots display will be fixed at the values they have when 

you start the WebShots Wizard, even if they are variable assumptions.  Therefore, you should set them to the 
values you want to use before starting the wizard. 

 

First set up your screen the way you want it 
to appear on the web in terms of the map 

symbology and which layers are on or off.   
 

The exercise below provides you with an 
example of how you might set things up 

using the Suitability and Common Impacts 

analyses you just ran on the Communityville 
data set.  

 
1. If the Communityville data set isn't 

already open, go to the Scenario 

360 menu, point to Analysis, and 
select Open and choose the Communityville data.   

 
2. Make sure that the Active Scenario is the Village scenario.  Zoom out until the squares representing the 

houses are not touching each other.   
 

3. On the Scenario 360 Analysis tab, click on Assumptions.  Change the Bird Nest Setback to 400 feet.  

This means that sites located closer than 400 feet to nests of particular bird species are not considered 
suitable.  Select "Yes" for the assumption called "Prohibit Building in Wetland Areas."  Click on the 

Apply button. 
 

4. Click the Scenario 360 menu, point to Presentation, and click WebShots Wizard.  [If the WebShots 

Wizard is grayed out or disabled, see CommunityViz help for the conditions necessary for it to be 
enabled.] 

 
5. The WebShots Wizard prompts you for various settings and preferences.  If in doubt about what 

information to provide on any given screen, simply click Next.  You will receive a helpful message if more 

information or different information is needed.  For detailed information on the required settings, see 
WebShots in the help. 

 
6. In the WebShots Wizard, click Next, and then choose both the village and rural scenarios. Click Next.  

 
7. Choose all three assumptions.  These will be variable, and viewers will be able to change one assumption 

at a time while other assumptions are set to default values.  Click Next twice. 

 
8. When the first window entitled "Choose Discrete Settings for Assumptions" appears, note that True and 

False are already in the WebShot Value(s) box on the right for the assumption "Prohibit Building in 
Wetland Areas."  Click Next.  

 

9. For the Water Tank Site, select Sites A, B, and C, and respectively click on the green arrow pointing to 
the right to select these as WebShot values.  Click Next. 

 
10. For the Bird Nest Setback, enter 200 (ft) in the left-hand box and click on the right-pointing green arrow 

to include this as a WebShot value.  Do the same with 400 and 600.  Click Next. 
 

11. On the window entitled "Choose WebShots," leave the Slide Show boxes blank, selecting only the 

"Explore" boxes.  Click "Next" and then "No" when a dialog box appears asking if you want to create Slide 
Show slides.  
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12. Click "Next" six times, accepting the defaults for each window that comes up.  Then click "Finish." 
 

To open your new Web Shots presentation, navigate to the WebShots subfolder of your analysis in Windows 
Explorer.  In here, there is another folder for the WebShots you just created.  Double-click the index.htm file in 

this folder to open the WebShots in your default browser.  If you have trouble viewing the WebShots or get 

errors, check the following: 

• The Web Shots viewer requires Adobe Flash player.  You should be prompted to install it if you don’t 
have it, or perhaps to allow it to run for this site.   

• Newer versions of Flash player cannot open local files, so you may get an error message indicating the 

WebShots data could not be read.  To work around this, you can add the WebShots folder to the local 
Flash Player security settings:  

1. Open the Global Security Settings panel: 
http://www.macromedia.com/support/documentation/en/flashplayer/help/settings_manager04.ht

ml#117502  

2. Under ‘Always trust files in these locations:’, add the path to the WebShots folder (you may need 
to enter the path in the text box instead of browsing for files). 

3. Close and re-open the browser and try opening the webshots file. 

Congratulations – you have completed Tutorial 6 
This tutorial has taken you through several different ways to prepare your analyses to be shared and presented.  

You have learned how to create saved views, reports in HTML format, and WebShots. We recommend you look 
back through the steps to review the Scenario 360 features you used and reflect on the overall approach to the 

analysis, focusing more on the functions than on the exact buttons and steps.    

 
 

http://www.macromedia.com/support/documentation/en/flashplayer/help/settings_manager04.html#117502
http://www.macromedia.com/support/documentation/en/flashplayer/help/settings_manager04.html#117502
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Tutorial 7 - Exporting Analyses to Google Earth™  

This tutorial will walk you through exporting an analysis for 3D viewing in Google Earth, exporting TimeScope 
build dates so you can look at changes over time in Google Earth, and exporting your analysis with 3D models 

from the CommunityViz Scenario 3D Library or any other KMZ model.  The 3D scene will open up to its proper 
global location as represented by satellite images, with your scenario displayed in three dimensions and your 

charts displayed in a window.  Most feature layers will be automatically “draped” on the Google Earth terrain.  

The files you export will be in Google Earth's .KMZ format which can be freely shared with others so they can 
view it in Google Earth as well.   

 

Requirements 
You must have installed Google Earth 4 or later onto your computer in order to take advantage of all of the 

features described here.  A high-speed Internet connection is also recommended.  Google Earth is an 
independent application that must be installed separately. Information is available at earth.google.com.   

 

Exporting an analysis to Google Earth – the basics 
1. Open the Sunny Vista analysis. 

2. Click on the Scenario 360 toolbar menu  Presentation  Google Earth Export Settings. 
3. On the General tab, note the default path name for the .KMZ file that Scenario 360 is about to create.  

(For future reference, you can change the file name or location by clicking the Browse  button.) 

4. Go to the Scenarios tab.  Choose to export both Proposal A and Proposal B.  

5. Go to the Layers tab.  To specify which layers to export, place a check by their name in the list on the 
left.  To set up particulars of how each layer will be exported, highlight its name in the list and then 

provide settings in the panel on the right.  For this exercise, check the following layers:  Streams, Ponds, 

Contour Lines, Roads, Elk Grazing Habitat, Parcels, and 3D Buildings. 
6. Click on the 3D Buildings layer so that it is highlighted and selected as the current layer.   

7. Change this layer’s “Export Layer As” setting to "Extrude Polygons" rather than "Geometry."  Note 
that this is only possible with polygon layers (not points, lines, or rasters). 

8. Change the color to one that you think would be suitable for a building. 

9. Select “Enter height manually” and change the height to 12 m.  This is the height to which all the 
buildings will be extruded.  (For future reference, you can use a height attribute in the layer instead.) 

10. Go to the Charts tab.  Select two or three charts that you would like to export to Google Earth.  
11. Click the Export Now button. 

 
Google Earth will launch and take you to the location of Sunny Vista. 

12. Use the Places list to determine which scenario you are looking at: A or B.  Change to the other scenario 

and experiment with selecting and deselecting layers. 
13. Move your mouse to the upper-right corner near the North arrow, and two slider bars and a rotating dial 

will appear.  Use these to change your viewing position of the scene.  The vertical slider changes the 
proximity to the scene and the horizontal slider changes your viewing height or viewing angle of the 

scene.  Use the dial to change the direction of view.  

14. Right-click on the 3D Buildings layer and select Properties.  Click "OK," choose the Style, Color tab, 
and click on the color box.  Select a different color and click 'OK.'  Notice that the color of the buildings 

changes.  Click 'OK.'  With the 3D Buildings layer still highlighted, try moving the slider bar at the bottom 
of the Places list to make the extruded buildings partly transparent. 

15. Below the scenarios in the Places list, expand the Charts folder and select one chart at a time to display.  

(Selecting the entire Charts folder will simply display all charts on top of one another, which is not 
recommended.)  

 

http://earth.google.com/
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Additional information on the settings for exporting to Google Earth can be found in the desktop Scenario 360 

Help. 
 

Exporting TimeScope™ build dates to Google Earth 
In this part of the tutorial you will be guided through exporting TimeScope build dates to Google Earth, where 
you will be able to visualize future scenarios as they change through time by using Google Earth Timeline.  

 

Exporting TimeScope build dates to Google Earth   
1. Open the Sunny Vista analysis in Scenario 360 if it is not already open. 

2. Run TimeScope, double click the Buildings layer, accept the default start and end dates, and choose 
linear growth. Accept all of the defaults, click Next as needed and then Finish to run TimeScope. 

3. In the ArcMap Table of Contents, expand the Build-Out layer and right-click on the Buildings layer to 
Open Attribute Table.  Make sure that the attribute called TS_BUILD_DATE exists in the attribute 

table.  Close the table.  
4. Go to: Scenario 360 toolbar menu  Presentation  Google Earth Export Settings. 

5. Go to the Scenarios tab.  Choose to export both Proposal A and Proposal B.  

6. Go to the Layers tab. Deselect any layers you don't want to export, such as the mask, or area boundary. 
7. Click on the Buildings layer and select Export Layer as: Geometry.   

8. Click the TimeScope tab. Any layers for which you have run TimeScope will be displayed.  Select the 
Buildings layer which has a TimeScope build date attribute (TS_BUILD_DATE). If you do not see any 

layer names displayed, you may have skipped a step.  

9. Go to the Charts tab.  Select the charts that you would like to export to Google Earth.  
10. When you are ready, click the Export Now button. 

11. Move your mouse to the upper-right corner near the North arrow, and two slider bars and a rotating dial 
will appear.  Use these to change your viewing position of the scene.  The vertical slider changes the 

proximity to the scene and the horizontal slider changes your viewing height or viewing angle of the 

scene.  Use the dial to change the direction of view.  
12. Notice the Timeline slider bar adjacent to the other slider bars. To mimic the behavior of a moving the 

TimeScope Time variable assumption slider bar in Scenario 360, set the Timeline’s left-hand slider to the 
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current year and move the right-hand slider into future years.  Notice that Google Earth Timeline allows 
you to display or hide features on the image according to their TimeScope build date.  

 

  
 

Using KMZ models in Google Earth™ 

In this part of the tutorial, you will learn how to use existing 3D models in KMZ format to represent buildings, 

trees or other map points in your Google Earth scene.  KMZ models are available in the CommunityViz Model 
Library (included with your software), or in Trimble's 3D Warehouse (sketchup.google.com/3dwarehouse/).  

You can create your own models using Trimble's free software SketchUp® (http://www.sketchup.com).  
 

1. Still in the Sunny Vista analysis, go to: Scenario 360 toolbar menu  Presentation  Google Earth 

Export Settings. 
 

2. Go to the Layers tab, click on the Buildings layer in the list, and choose Export Layer As: 3D 
Models.    

 
 Note: Only point layers can be exported as 3D Models.   

 

3. Choose “Select a random 3D model from a list.”  Using the Browse for Model Files  button, go 
to C:\KMZ Model Library and choose a house model.  (For future reference, if you have more than one 

model, you can add all of them here.  Scenario 360 will choose a random model for each point.) Once 
you have found a model, click Open. 

 

4. If desired, you can orient (turn) your model so it faces a particular direction such as towards the nearest 
road by entering an orientation (in degrees) manually, or by referring to a numeric attribute in the point 

layer.   
 

 Advanced tip:  you could write a simple dynamic attribute formula using the AngleTo function that gives 

 the angle to the nearest road, and then use that as an orientation field.   
 

5. Click on the Export Now button and Google Earth will be launched.  If you select the Buildings layer to 
be displayed, your new model will appear. 

 
Note: You can specify Google Earth models in the Visual portion of the Scenario 360 Build-Out Wizard if 

desired.  After doing so, choose “Get 3D model file from a field” in the Layer export settings and choose the 

attribute field called “3D Model.” 
 

 

Using SketchUp and 3D Warehouse models 
In addition to the CommunityViz KMZ Model Library, you can obtain 3D models from Trimble’s on-line 3D 

Warehouse or you can make your own using SketchUp.  For either of these options, you will need to download 
and install SketchUp from http://www.sketchup.com.  

 
1. Go to the Trimble 3D Warehouse at: https://3dwarehouse.sketchup.com  

 

This is a site that hosts three-dimensional images that are posted by members of the public.  Search for a 
house of the Cape Cod style by typing "Cape Cod" in to the search engine and clicking "Search." Select a 

house by double-clicking on it, and then click the Download to SketchUp button. When you are 
prompted, select Open with SketchUp rather than Save to Disk.  

 

http://www.sketchup.com/
https://3dwarehouse.sketchup.com/


91 

  - OR - 
  

Create a model of your own in SketchUp.  Follow the directions within SketchUp or their tutorials. 
 

2. Once your selected 3D Warehouse model has been opened up in SketchUp or you have created your own 

model in SketchUp, export your model into Google's .KMZ format so that it can be imported into Google 
Earth.  Normally models are saved in SketchUp as .SKP files.  To export the file, go to the SketchUp 

menu and choose File  Export  3D Model.  Save it as a Google Earth *.KMZ file in your analysis 
directory or in your local KMZ Model Library.  Examples: 

 
C:\CVFiles\3D Models\KMZ\CapeHouse.kmz 

 

- OR -  
 

 C:\CVFiles\Sunny Vista\3D\GoogleModels\CapeHouse.kmz.  
 

 
 

You may also go to File  Preview in Google Earth to launch your model in Google Earth. 

 
On your own, try resetting the Buildings layer export settings to use the Cape House, and see how it looks! 

 
When you are finished using Google Earth, close the window and, when asked whether you want to save items to 

your “My Places” folder, answer No. 

Congratulations – you have completed Tutorial 7 
This tutorial has taken you through exporting a scenario to Google Earth, exporting TimeScope build dates to 

Google Earth, and using a SketchUp 3D model to represent points in the Google Earth scene.  We recommend 

you look back through the steps to review the Scenario 360 features you used and reflect on the overall approach 
to the analysis, focusing more on the functions than on the exact buttons and steps.   
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